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2  Chapter 1– Welcome

Welcome to the IC-301 Print Controller User Guide
Welcome to your IC-301 Print Controller for the bizhub™ PRO 
C500 Printer User Guide. This user guide provides you with 
information about the bizhub PRO C500 printer.

This user guide will help you operate the IC-301 print controller. It 
can also be used as a reference guide for questions or procedures. 
Study this user guide to take full advantage of the many unique and 
advanced features of the IC-301 print controller.

This user guide is for IC-301 print controller operators and system 
administrators and explains how you can quickly and easily print 
from the IC-301 print controller or from a client workstation. Step-
by-step procedures are included for new and occasional IC-301 
print controller users. Detailed information is provided for users 
who require in-depth knowledge of the IC-301 print controller. 

Overview of IC-301 Print Controller
The IC-301 print controller is an on-demand prepress system that 
uses Creo advanced prepress technologies, to drive a bizhub PRO 
C500 printer. 

As an optimal digital color solution for printers, the IC-301 print 
controller enables you to print from Windows, Macintosh, and 
UNIX® client workstations. The IC-301 print controller processes 
image files in page-description language (PDL) formats—for 
example, PostScript, PDF, and Variable Information—using RIP 
(Raster Image Processor) technology. The system converts image 
files into a suitable processed format for direct, high-quality digital 
printing. The IC-301 print controller also streamlines the printing 
process by allowing printing with preset workflows.

In combination with the bizhub PRO C500 printer, the IC-301 print 
controller enables you to efficiently print flyers, brochures, 
pamphlets, dummy catalogs, short-run trials, and print-on-
demand publications. When installed as a fast network printer with 
the IC-301 print controller, the bizhub PRO C500 printer prints up 
to 51 full-color A4 (210mm x 297mm) or 50 Letter (8.5 inches x 
11inches) pages per minute.
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The IC-301 print controller combines RIP functionalities, 
automation, control tools and special hardware development 
capabilities with PC architecture.

Hardware and Software Components
The IC-301 print controller is a dedicated KONICA MINOLTA platform 
that runs in a Windows XP environment.

The IC-301 print controller includes:

• KONICA MINOLTA hardware, including the interface board

• KONICA MINOLTA software

• Windows XP® Professional operating system

• Adobe® Acrobat® 6.0
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Supported File Formats
The IC-301 print controller supports the following file formats:

• PostScript (composite or pre-separated files)

• PDF 

• EPS

• Creo VPS (Variable Print Specification)

• PPML (Personalized Print Markup Language)

• JPG

• Pre-separated formats

The IC-301 print controller can import and covert the following 
GAP (Graphic Art Port) file types:

• Brisque jobs

• TIFF

• TIFF IT

• CT / LW



Overview of IC-301 Print Controller 5

Workflow
The IC-301 print controller basic workflow is as follows:

IC-301 Print Controller Network Printers
The IC-301 print controller provides three default network printers, 
known also as virtual printers.

Virtual printers are a function used for automating workflows, 
which then define job streaming. They contain preset workflows 
that are automatically applied to all print jobs processed with that 
virtual printer. There is no need to reset job settings for each job, 
thus increasing printing efficiency.

Note:  By default, the job parameters set in the job (from the client 
workstation) override the parameters set in the virtual printer. If you add or 
edit a virtual printer, you can select the Override PPD parameters check box 
to override the parameters set in the PPD file.
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The three default virtual printers are:

• Store

Files are spooled directly to the Storage area and await operator 
processing. You can only import PDL files (such as: PostScript, 
PDF, VPS) to this virtual printer, not RIPped - processed files. 

• Print

Files sent to this virtual printer are processed and printed 
directly to the bizhub PRO C500 printer via the IC-301 print 
controller.

• Process

Files sent to this virtual printer are automatically processed. 
After processing, the files are stored in the Storage area of the 
IC-301 print controller until the print operator re-submits them 
for printing.

With printing workflows tailored to your job requirements, the IC-
301 print controller enables you to: 

• Define new virtual printers

• Choose from which virtual printer to print

For information on creating and editing virtual printers, see Creating Virtual 
Printers on page 79.
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Turning On the IC-301 Print Controller
1. Turn on the monitor.

2. Open the front panel of the IC-301 print controller, and then 
press the power control button.

The power indicator on the front panel lights up and the 
Windows operating system starts.The IC-301 print controller 
splash screen appears followed by the workspace.

Notes:

• If the workspace doesn’t appear automatically, select Start> IC-

301>IC-301 from the Windows Start menu.

• By default, the Auto Log On check box is selected in the 
Preferences window. This option enables you to open the 
workspace without having to go through the IC-301 print 
controller logon process each time. If you want each user to 
have to log on to the IC-301 print controller, clear the Auto Log 

On check box, and then assign each user an access level and 
password.



The Workspace 9

The Workspace
After you turn on the IC-301 print controller, the workspace 
automatically appears.

For more information about designating access levels, see Security on 
page 137.

6

1
2
3

5

4
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Table 1 describes the IC-301 print controller workspace. 

Table 1: IC-301 print controller workspace

Item Name Description

1 Title bar Displays the name of your server and the access level with 
which you logged on

2 Menu bar Consists of the File, Manage, Queues, Tools, Info, and Help menus. 
Click a menu name to open the corresponding menu.

3 Toolbar Consists of shortcut buttons for the Import window, Resource 
Center, Calibration, Spot Color Editor, Gradation, and Alerts

4 Printer Status Displays messages about the current printer state and your 
printer configuration. You can also find information about the 
paper in each tray, the connected finishing devices, toner 
availability, and disk space and network details.

5 Queues Consists of the Process Queue, which lists the files to be 
processed. After a file has been processed successfully, it 
moves either to the Print Queue (the upper area) or to the Storage 
area.

6 Storage  The Storage area contains files that:

• were successfully printed

• were held, were aborted, or failed during processing or 
printing

• were sent directly from the client workstation to the Storage 
area or were imported to the Storage area
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The Printer Status Pane

The Printer Status pane displays information about the current 
printer status—for example, Printing.

The printer icon displays the current printer configuration, 
according to the connected feeders and finishers.

Click Trays, Finishers, Toners, or Server to display information about 
the size and type of paper in each tray, the connected finishing 
devices, the available toner, and disk space and network details. 

Under Server, you can also view the date that the printer was most 
recently calibrated. Progress bars display information about 
incoming and outgoing jobs. 
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If there is a problem with one of the printer components or with the 
server, a red indicator appears in the printer icon and next to the 
relevant component—for example, if a tray is empty. 

.

The Alerts Window 

The Alerts window lists all of the alert messages that are generated 
during the workflow.

To open the Alerts window:

On the toolbar, click Alerts.

The window has two view options:

• All: To view all messages

• Selected: To view alerts related to a selected job. This is the 
default view.
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The Job Info Area

 

The Job Info area displays a small image of each page in the 
selected processed job. The Job Info area also contains the 
following information:

• Job’s title

• File type

• Paper size

• Print range

• Total number of pages in the job

• Total number of copies to print

• A box to enter the required page number and arrow buttons to 
browse through the pages of your job

To open the Job Info area:

Right-click a job in the Process Queue or Print Queue, and from 
the menu, select Job Info.
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The Preferences Window

You can set all system preferences in the Preferences window. 

To open the Preferences window:

From the File menu, select Preferences. 

The window is divided into two areas: 

• Administrator: All users can view these settings, but configuring 
these settings depends on the access level defined for each 
user. 

• General: All users can view these settings, but only an 
administrator or operator can configure the settings. 

Note:  If you log on to the IC-301 print controller as a guest, the Preferences 
window is unavailable.

For more information about setting system preferences, see Setting Up and 
Configuring the IC-301 Print Controller on page 128.
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The Resource Center

The Resource Center enables you to add, remove, and manage 
external resources for the IC-301 print controller.

To open the Resource Center:

On the toolbar, click Resource Center .

The Resource Center provides access to the following resources: 

• Virtual printers, in which you can create, edit and remove virtual 
printers, see Creating Virtual Printers on page 79

• Fonts, see Managing Fonts on the IC-301 Print Controller on 
page 99

• Profile Manager, see Managing Profiles on page 108

• Backup & Restore configuration, see Backing Up and Restoring 
the Configuration on page 153



16  Chapter 2– Getting Started

The Job Parameters Window 
The IC-301 print controller enables you to edit imported PDL files 
and change the job settings—for example, paper size, imposition, 
and color settings—in the job parameters window.

In the queues or Storage area, double-click the job whose 
parameters you want to view.

The job parameters window appears.

Note:  In the queues, you can edit the parameters of jobs that have not begun 
to run. If you want to edit the parameters of a running job, you must first 
suspend the queue (click the suspend button).

Note:  If you edit the parameters of a job in the Print Queue and the changes 
require re-RIPing of the job, it automatically moves to the Process Queue.
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Each area in the job parameters window—for example, Print, 
Imposition, or Quality— has a set of related parameters and values 
that you can select.

Table 2: Description of buttons in the job parameters window

This button Enables you to

Print Set print related parameters—for example, 
Print range and Media Type. See Print on 
page 156

Imposition Set parameters related to print layout—for 
example, Trim Size and Imposition Method. 
See Imposition on page 159

Quality Set parameters related to print quality—for 
example, Trapping and High Image Quality—
and improve the quality of printed jobs. See 
Quality on page 164

Color  Apply last minute color corrections, or set 
the output job to match other output 
devices. See Color on page 166 

Finishing Set parameters related to finalizing your 
printed document—for example, define 
settings for the front and back cover. See 
Finishing on page 170 

Exceptions Include special exceptions in a job—for 
example, use a different media type for a 
front and back cover. See Exceptions on 
page 174

Services Set parameters that will assist your job 
workflow—for example, delete jobs, in the 
change the location of the entire printed 
image, or enter job information. See Services 
on page 176
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The Help Menu
The Help menu enables you to access the user guide and provides 
information about the current version of the IC-301 print controller 
installed on your computer.

To open the About window:

From the Help menu, select About.

The About window displays the following information:

• IC-301 print controller version number

• Date the version was installed

• Any updates that were installed on top of the version

To open the user guide:

From the Help menu, select Topics.
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Turning Off the IC-301 Print Controller
1. From the File menu in the workspace, select Exit. 

If there are jobs that are being processed or printed, the 
following message appears:

There are currently jobs running, are you sure you want 
to exit the application?

If there are no jobs being processed or printed, the following 
message appears:

Are you sure you want to exit the application?

The IC-301 print controller workspace closes, and you return to 
the Windows desktop.

2. Verify that the IC-301 icon has disappeared from your taskbar.

3. From the Windows desktop, select Start>Shut Down. 

4. In the shutdown dialog box, select Shut down.

5. When the Windows shutdown is complete, turn off the 
monitor.

6. On the IC-301 print controller, click the power button behind 
the front door. 
The power LED on the front panel turns off. 

Taskbar with IC-301 icon Taskbar without IC-301 icon

Note:  Some situations may require the power button to be depressed for 
more than 4 seconds.
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Overview 
To print a job from a client workstation, select one of the following 
methods:

• Print the job via one of the IC-301 print controller network 
(virtual) printers—for example, Print.
The job is spooled and then processed or printed (according to 
the selected job flow of the virtual printer). If you use this 
method, you can print from any application —for example, 
Microsoft Word— and use any file format from any client 
workstation (Windows, Macintosh, or UNIX).

• Drag the files to a hot folder.
The job is spooled and processed or printed (according to the 
selected job flow of the corresponding virtual printer). 

If you use the hot folder method, you can print most PDL files 
on the IC-301 print controller— for example, PostScript, PDF, 
EPS, and Variable Print Specification files. 

For more information about printing from a client workstation, see Printing 
From Windows on page 26 and Printing from a Macintosh on page 31.

For more information about hot folders, see Using Hot Folders on 
page 36.

Note:  PDL jobs that are spooled to the IC-301 print controller must have 
the appropriate file name extensions—for example, *.ps or *.pdf.
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Defining a Printer in Windows
The IC-301 print controller can print from a Windows client 
workstation that has one of the following operating systems:

• Windows ME

• Windows NT 4.0

• Windows 2000

• Windows XP

• Windows 2003

• Windows 2003 Server

The following section describes how to define a IC-301 print 
controller network printer for Windows XP.

You use the Windows Add Printer wizard to define the IC-301 print 
controller network printers. 

Defining a Printer - Windows XP

To define a network printer using the Windows Add Printer wizard:

1. On your desktop, click the Start button and select 
Settings>Printers and Faxes.

2. In the Printer Tasks area, select Add a printer.

The Add Printer wizard appears.

3. Click Next.

Note:  When you add a new IC-301 print controller network printer to a client 
workstation, there is no need to install the IC-301 print controller PPD file and 
Adobe PostScript printer driver separately. They are installed automatically in 
the Windows Add Printer wizard.
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4. Select A network printer, or a printer attached to another computer 

and then click Next.

5. Select Browse for a printer, and click Next.

6. Find the IC-301 print controller and double-click it to display the 
list of network printers.

7. Select the printer you wish to setup, and click Next.

8. Select Yes if you want to set this printer as the default printer 
on your computer. Otherwise, select No.
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9. Click Next.

10. Click Finish to close the wizard.

The IC-301 print controller network printer is added to your 
printer list.

To define a network printer in Windows XP using the network 

neighborhood:

1. Browse to the IC-301 print controller and open it.

2. From the list of network printers, find the desired network 
printer.

3. Double-click on the network printer icon.

4. The network printer is defined on your Windows client 
workstation.

Copying the Printer Driver from Windows
Perform this procedure if your client workstation is not on the same 
network as the bizhub PRO C500 printer and you want to create 
PostScript files.

1. In the IC-301 print controller, locate the D:\ drive and then 
double-click the Utilities folder.

2. Click PC utilities, and then Printer Driver.

3. Find the directory of the driver relevant to your version of 
Windows.

4. Compress the directory, and either copy it to a disk or send it 
by email to the customer. 

Note:  To install additional network printers, repeat the process
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Printing From Windows
1. Open the file you would like to print in the corresponding 

application—for example, open a PDF file in Adobe Acrobat.

2. From the File menu, select Print. 

The Print dialog box appears.

3. In the Name list, select the desired IC-301 print controller 
network printer—for example, <servername>_Print.

4. If desired, click Properties and modify the job parameters.

5. Click OK.

Notes:

• Unless the Override PPD Parameters option was selected in the 
virtual printer, any changes to the printer parameters override the 
parameters of the selected virtual printer. 

• Printer's Default indicates that the value is taken from the settings 
of the selected virtual printer on the IC-301 print controller.
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6. Click OK in the Print dialog box.

The file is sent to the IC-301 print controller. 

Defining a Printer on Macintosh Client Workstations
This section describes how to define a IC-301 print controller 
network printer for Macintosh client workstations. The IC-301 print 
controller can print to Macintosh client workstations running Mac 
OS 9 and Mac OS X (10.3).

You can also submit jobs using the IC-301 print controller virtual 
printers over a TCP/IP protocol. This connection enables a 
significantly higher spooling speed.

Copying the IC-301 Print Controller PPD File for Mac OS 9
To print from your Macintosh computer to the bizhub PRO C500 
printer, you first need to manually copy the IC-301 print controller 
PPD file to the Macintosh.

1. From the Apple menu, select Chooser.

2. Select AppleShare, and then locate the IC-301 print controller 
on the network.

3. Click OK. The Login window appears.

4. Select the Guest option, and then click Connect.

The corresponding IC-301 print controller window appears.

5. Select Utilities, and then click OK.

6. On the desktop, double-click the Utilities volume.

The Utilities window appears.

For more information abut setting PPD file settings, see Setting Parameters 
in the PPD File on page 180.

Note:  Do not select the Utilities check box. If you do, Utilities will mount 
each time you restart your computer.
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7. Double-click the PPD folder, and then double-click the folder 
for the desired language—for example, English. 

8. Copy the PPD file to the System Folder>Extensions>Printer 

Descriptions folder.

The IC-301 print controller PPD file is now installed in the 
Printer Descriptions folder. It is ready to be configured with one 
of the IC-301 print controller network printers. 

Setting the Network Printer for Mac OS 9
1. Make sure that the IC-301 print controller PPD file has been 

copied to the Printer Descriptions folder on your client 
workstation.

2. From the Apple menu, select Chooser.

3. Select LaserWriter and then locate the IC-301 print controller 
on the network.

4. Select one of the IC-301 print controller's network printers—
for example, <servername>_Process—and click Create.

The system automatically locates the IC-301 print controller 
PPD file and configures the printer as a IC-301 print controller 
network printer.

If you have the Desktop Printer Spooler extension enabled, a 
printer icon appears on the desktop. 

For more information about copying the PPD file, see Copying the IC-
301 Print Controller PPD File for Mac OS 9 on page 27.

Note:  Use this icon when you want to download PostScript files to the IC-
301 print controller.
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Copying the IC-301 Print Controller PPD File for Mac OS X (10.3)
To print from your Macintosh computer to the bizhub PRO C500 
printer, you first need to manually copy the IC-301 print controller 
PPD file to the Macintosh. 

1. From the Go menu, select Connect to Server.

The Connect to Server dialog box appears.

2. Locate the desired IC-301 print controller in the network and 
then double-click it.

3. In the Connect to Server dialog box, select Guest. 

4. Click Connect.

5. Select the Utilities volume, and click OK.

6. On the desktop, double-click the Utilities volume icon.

7. Double-click the PPD folder. 

8. Double-click the English folder.

9. Double-click the MAC folder and locate the IC-301V1.PPD file. It 
is recommended that you copy the PPD file by dragging it to 
the specified folder in your local disk. To do this open another 
Finder window.

10. From the Go menu, select Computer.

11. Click the MacOSX disk icon, and locate the following folder:
Library\Printers\PPDs\Contents\Resources\en.lproj.

12. Drag the IC-301V1.PPD file to the en.lproj folder.

Setting the Network Printer for Mac OS X (10.3)
1. Copy the IC-301 print controller PPD file to the 

Library\Printers\PPDs\Contents\Resources\en.lproj folder on your 
client workstation.

2. From the Go menu, select Applications.

For more information about copying the PPD file, see Copying the IC-
301 Print Controller PPD File for Mac OS X (10.3) on page 29.
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3. Open the Utilities folder and then double-click Printer Setup 

Utility.

4. Click Add.

5. In the upper box, select Apple Talk. 

6. In the lower box, select the required AppleTalk Zone from the 
list (as instructed by your system administrator).

7. Locate the IC-301 print controller name in the list.

8. From the printers list, select <server_name>_Print.

Any jobs sent to this printer will be automatically processed, 
printed, and stored.

9. In the Printer Model list, select Other.

10. In the Choose a File dialog box, double-click the folder to 
which you copied the PPD file: 
MACOSX\Library\PPDs\Contents\Resources\en.lproj.

11. Locate the IC-301V1.PPD file and double-click it.

12. Click Add. 

You have successfully installed a network printer for the IC-301 
print controller and are ready to start printing.
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Printing from a Macintosh
1. Open the file you would like to print, in the corresponding 

application—for example, open a Quark file.

2. From the File menu, select Print.

3. In the Printer list, select the desired printer—for example, 
<server_name>_Print.

4. In the Copies & Pages list, select Printer Features.

A window similar to the one shown below appears. You can set 
job parameters.

For more information about installing the IC-301 print controller network 
printers on client workstations, see Copying the IC-301 Print Controller 
PPD File for Mac OS 9 on page 27 and Setting the Network Printer for 
Mac OS X (10.3) on page 29.
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5. Adjust the printer options as desired.

6. After modifying the job settings, click Print.

The file is sent to the IC-301 print controller. 

Web Center
The Web Center is a web page that provides online information and 
can be accessed from client workstations. 

The Web center enables you to:

• View the status of jobs in the queues, the Alerts window in its 
current state, and the printer system information

• Download remote client tools, utility applications, color profiles, 
and print drivers

Notes:

• The Printer's Default option indicates that the value is taken from 
the virtual printer that is currently selected.

• The PPD parameters are divided into eight feature sets.
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To connect to the Web Center from a client workstation:

1. On your desktop, click the Internet Explorer icon.

2. When the Internet Explorer starts, in the address field type: 
http://<IC-301 name>—for example, if the IC-301 station 
name is FALCON_E, type http://FALCON_E.

Important:  To connect to the Web Center from a client workstation, you 
must first enable the web connect service on the IC-301 print controller, see 
Remote Tools Setup on page 136.

Note:  To connect to the Web Center, use Internet Explorer 5.0 or later.

Note:  You can also use the IC-301 print controller IP address—for 
example, 
http://192.168.92.10.

Important:  If you would like to connect to the IC-301 print controller 
from a Macintosh client workstation, contact your system administrator 
to add the IC-301 name to the DNS. This is required since Windows 
name resolution protocols are not supported in Macintosh. The DNS 
addition is required when clients go through a main server on the 
network.
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The IC-301 print controller Web Center appears. 
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The Web Viewer
The Web Viewer page consists of three tabs and enables you to 
view the jobs that currently reside in the IC-301 print controller 
queues and Storage area, and also view messages that currently 
appear in the Alerts window. This information is important when 
you print from a client workstation because it enables you to 
monitor your jobs in the queues and then make any necessary 
changes. 

Web Viewer API
If you have an application that uses XML protocol, the JobList.xml 
file and the Printer Status.xml file enable you to retrieve information 
about the job list and the printer status.

The JobList.xml file contains information about files in the Print 
Queue, Process Queue, and the Storage area.

To see the Job List view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=JobList_xml.

The Printer Status.xml file contains information about the various 
printer states. To see the Printer State view, type the following 
path: 
http://<ComputerName>/WebViewer/

GetView.asp?View=PrinterStatus_xml.

Table 3: Description of Web Viewer tabs

This tab Enables you to view

Queues Jobs that are currently running in the IC-
301 print controller Print Queue and Process 

Queue. 

Storage IC-301 print controller Storage area and the 
jobs that reside in this window

Alerts IC-301 print controller alerts. For example, 
if a job that you sent to print from your 
client workstation has failed—you can view 
the message in the Alerts window, edit the 
job parameters, and then resend it for 
processing and printing on the IC-301 print 
controller.
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Downloads
The Downloads page enables you to download the most updated 
IC-301 print controller utilities for Windows and Macintosh client 
workstations. You can download the following items:

• PPD file

• Color profiles

• Utilities folder

Using Hot Folders
For every published IC-301 print controller network printer that you 
define on a client workstation, a corresponding hot folder is 
automatically created in the IC-301 print controller D:\Hot Folders 

folder. The IC-301 print controller has three default hot folders, 
HF_Print, HF_Process, and HF_Store. These hot folders correspond 
to the three default printers.

Each hot folder carries the virtual printer's name (HF_printer’s 
name), see the following graphic.
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When you connect from a client workstation to the IC-301 print 
controller over the network, you can use the hot folder to submit 
PDL jobs to the IC-301 print controller. When you establish a 
connection, drag your jobs onto the desired hot folder (according 
to the selected workflow).

Jobs that reside in the hot folder will automatically be submitted to 
the IC-301 print controller through the corresponding virtual 
printer. Consequently, all of the virtual printer job parameters, 
inclusive of the workflow, will be applied to the job.

As soon as the job has been spooled to the IC-301 print controller, 
it disappears from the hot folder and enters the IC-301 print 
controller Process Queue or Storage area, according to the selected 
workflow.

Hot Folder File Formats
Hot folders may contain all PDL formats that are supported by the 
IC-301 print controller, PS, PDF, EPS, PRN, VPS, PPML, TIF, JPG 
and GAP. 

Files with unsupported formats that are moved to a hot folder, will 
not be imported to the IC-301 print controller and will remain in the 
hot folder.

Tip:  You can also drag the hot folder icon to your desktop and create a 
short cut to the hot folder.

Note:  If you send files for printing through a hot folder while the IC-301 print 
controller application is down, when the application restarts, the files that 
reside in hot folders will immediately be imported to the system.

Note:  When you use hot folders to print GAP jobs, the process is automated 
and the job is converted to a PDF, which is displayed in the IC-301 print 
controller queues. The PDF files can then be programmed and printed as any 
other PDF file.
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Using Hot Folders From Your Computer
You can use hot folders to process and print files from any 
computer. The following procedures explain how to print using hot 
folders from Windows and Macintosh OS X.

To print a job using a hot folder from Windows:

1. On your Windows desktop, double-click the Network 

Neighborhood icon. 

2. Find your IC-301 print controller.

3. Double-click the IC-301 print controller. 

4. Double-click the desired hot folder—for example, HF_Process.

You can now drag the desired files to the hot folder. All the files 
are processed and printed automatically to the printer, 
according to the hot folder workflow.

To print a job using a hot folder from a Mac OS X:

1. From the Finder menu bar, select Go>Connect to Server.

The Connect to Server window appears.

2. Find your IC-301 print controller on the network, and click 
Connect.

3. Select Guest, and then click Connect.

4. From the list, select the desired hot folder—for example, 
HF_Process—and then click OK.

The hot folder icon appears on your desktop. You can now drag 
the desired files to the hot folder icon. All the files are 
processed and printed automatically to the printer, according 
to the hot folder workflow.

Tip:  You can also drag the hot folder icon to your desktop to create and 
use a shortcut to the folder in the future.
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Setting Up the Remote Desktop
The Remote Desktop utility enables you to connect, view, operate, 
and perform administrative procedures on the IC-301 print 
controller from a client workstation. While the remote connection 
and operation takes place, the regular operation of the IC-301 print 
controller is not affected. 

The Remote Desktop utility is integrated into the Windows XP 
Professional operating system, while for Windows 9x 98/ME, 2000, 
and Mac OS, the remote desktop must be set up. 

Setting up the remote desktop connection utility for Windows 9x 98/
ME, 2000:

1. From the system administrator workstation, connect to the 
desired IC-301 print controller, and double-click the Utilities 
folder.

2. Double-click the PC Utilities folder, and then double-click the 
Remote Desktop.EXE file.

3. On your desktop, click 
Start>Program>Accessories>Communications>Remote Desktop 

Connection.

The Remote Desktop Connection dialog box appears.

4. In the Computer box, type the host name, and then click 
Connect.

The Log On to Windows dialog box appears.

Notes:

• Only one user at a time can operate and perform administrative 
tasks on the IC-301 print controller workspace, either from the 
Remote Desktop utility or the IC-301 print controller.

• This tool is designed exclusively for the system administrator. 
Users that want to connect to the IC-301 print controller from a 
client workstation can use the Web Center to view and monitor 
jobs in the IC-301 print controller queues.

For more information about viewing jobs from a client workstation, see Web 
Center on page 32.
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5. In the User name box, type your user name.

6. In the Password box, type your password.

7. Click OK.

The desktop appears.

Setting up the remote desktop connection utility for Mac OS X:

1. From the system administrator workstation, connect to the 
desired IC-301 print controller, and double-click the Utilities 
folder.

2. Double-click the Mac Utilities folder, and then drag the 
RemoteDesktop.hqx file on your desktop.

3. Double-click the RemoteDesktop.hqx file.

The Remote Desktop Connection window appears.

4. Drag the Remote Desktop Connection directory to the Application 
folder on your local disk.

5. Double-click Remote Desktop Connection.

The Remote Desktop Connection (RDC) window appears.

6. In the Computer box, type the IC-301 print controller name or 
IP address, and then click Connect.

The Log On to Windows dialog box appears.

7. In the User name box, type the Windows user name for the IC-
301 print controller.

8. In the Password box, type the Windows password for the IC-
301 print controller.

9. Click OK.

The IC-301 print controller workspace appears.

Note:  The default logon user name for Windows XP is Operator, and the 
password is colorserver.
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Basic Job Workflow
The basic workflow in the IC-301 print controller consists of three 
main stages:

1. Submitting a file from a client workstation, or importing and 
printing from the IC-301 print controller, see Submitting on 
page 42

2. After a job is imported, the print engine starts to process the 
job, see Processing on page 42

3. The job is printed and stored in the Storage area for future use, 
see Storage on page 43

Submitting 
There are two methods for submitting a file for printing:

• Submit a file from an application on your client workstation—for 
example, PDL formats that were created on client workstations 
that are not connected to the IC-301 print controller, or files 
that are available only on external media. 

• You can also import job files that reside locally on the IC-301 
print controller.

Processing 
After a job enters the IC-301 print controller, it resides in the 
queues or the Storage area, depending on the job flow. The queues 
consists of two areas: 

• The Process Queue lists the job currently being processed and 
all the jobs that are waiting to be processed. 

• The Print Queue lists the job that is currently printing and all the 
jobs that were processed successfully and are waiting to be 
printed. The Print Queue also lists held jobs—for example, jobs 
for which the specified paper stock is not available.

Each queue holds jobs in the order in which they enter the queue. 
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The top job in the queue is the currently running job, while all the 
others are waiting to run. The Print Queue and Process Queue areas 
show you the number of jobs and their status. You can change the 
order of jobs, view and edit the parameters. The suspend and 

resume buttons in each queue indicates whether the queue is 
suspended (red) or not (green).

Storage

For more information about how to manage the queues, see Managing the 
Job Queues on page 54.
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The Storage area is the main repository for jobs. It can contain:

• Completed jobs

• Jobs that were manually moved to the Storage area

• Jobs that were aborted during processing or printing

• Jobs that failed to complete processing or printing

• Jobs that were imported or spooled directly from a client 
workstation 

Importing and Printing Jobs
You import jobs for printing in the following situations:

• When a page-description language (PDL) file is created on a 
client workstation that is not connected to the IC-301 print 
controller

• When a PDL file is located on an external medium, such as a 
CD-ROM

• When the desired file resides locally on the IC-301 print 
controller

Importing Files

To import files to the IC-301 print controller:

1. From the File menu select Import. 

The Import window appears. 

For more information about the Storage area, see Managing the 
Storage Area on page 62.
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2. To access the desired files, click the up one level button , 
or double-click on the file folders to go down the file tree.

3. In the upper list in the Import window, select the desired file 

and click Add .  

The file appears in the lower list.

4. Select a printer from the Virtual Printer list.   

5. Click Import.

All files currently listed on the lower list are sent to the IC-301 
print controller to be processed and printed as defined in the 
selected virtual printer.

Note: To remove a file, select the desired file in the lower list in the 

Import Job window and click Remove .
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Resubmitting 
You can easily reprint processed jobs that are stored in the Storage 
area. Select the job you want to reprint and then submit it. The job 
is automatically placed in the Print Queue. 

The IC-301 print controller enables you to change job parameters 
and edit jobs prior to reprinting.

You can change job parameters in the job parameters window. 
Certain changes to the job parameters require you to re-RIP the 
job. The IC-301 print controller automatically determines whether 
your file requires re-RIPing and places it in the appropriate queue 
when you submit it for reprinting.

Remote Scanning Application
Before you begin using the the Remote Scanning Application, you 
need to install the application on your client workstation. You can 
find the setup file in the Utilities folder on the installation CD. 

The Remote Scanning Application enables you to:

• Set up scan boxes either from the bizhub PRO C500 printer or 
your client workstation, and then set parameters that specify 
the location of your scanned data, the format in which it is 
saved, and security settings

• Manage scanned images

A typical scanning workflow with the Remote Scanning Application 
is as follows:
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Setting Up Scan Boxes
You can set up scan boxes:

• On the bizhub PRO C500 printer. This enables you to set up a 
scan box on the fly, and then scan an image. You can modify 
the scan box settings later on the IC-301 print controller, see 
To set up a scan box from the bizhub PRO C500 printer: on 
page 47.

• On the Remote Scanning Application. This provides a central 
location for the system administrator manage the scan boxes, 
and set security, see To set up a scan box from the Remote 
Scanning Application: on page 48.

To set up a scan box from the bizhub PRO C500 printer:

1. On the printer’s control panel, press the SCAN key.

2. On the printer’s touch screen, touch the HDD button. 

3. Touch the Add manual input button, and then touch the Address 

manual input box.

4. Touch the Input Key Indicate button, and then on the control 
panel type a name for the new scan box.

5. On the touch screen, touch the OK button.

6. Touch the BoxNo box. 

7. On the control panel, type a serial number for the scan box.
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8. On the touch screen, touch OK.

9. Place the image that you want to scan on the printer, and then 
press the START key.

10. To access your scanned data, open the Remote Scanning 
Application, see Managing Scanned Images on page 50

To set up a scan box from the Remote Scanning Application:

1. From the Start menu, select Programs>KIM>Remote Scan 

Application>Remote Scan.

2. From the Server Name or IP list, type, or choose, the server 
hostname or IP address to which you want to connect, and 
click Connect.

3. In the Remote Scanning Application dialog box, click the Scan 

Box Manager button. 

The scan box list is displayed. 

4. Click the Add button to add a new scan box. 
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5. In the Scan Box Name box, type a name for the scan box. 

6. Select the Automatic Copy checkbox to specify that your data 
is automatically copied to the scan box. 

7. In the Network Path box, enter the location to which you want 
to save the scan box.

8. In the File Type box, enter the format in which you want to save 
the data that is saved to the scan box. The available options 
are JPEG, TIFF and PDF.

9. Select Security. 

10. Select the Secure Scan Box checkbox to secure the scan box, 
and specify a password. 

Click Apply, and then Save.
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Managing Scanned Images
The Remote Scanning Application provides the following default 
scan boxes: 

• Public—the settings for the Public folder can be managed by all 
users or by an administrator only. These settings are specified 
in the Preferences window. For more information, see Scan 
Management on page 141. 

• Scan to Print—from which data is sent to the Process Queue to 
be processed and printed.

• Calibration—which contains the data saved during calibration. 

To manage scanned images:

1. From the Start menu, select Programs>KIM>Remote Scan 

Application>Remote Scan. 

2. From the Server Name or IP list, type, or choose, the server 
hostname or IP address to which you want to connect, and 
click Connect.

3. From the ScanBox list select the scan box you want to access. 
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All jobs scanned to the selected scan box are displayed.

4. Select the desired job, and click Save.

The Save dialog box opens.

5. Select a destination, and click Save. 

You can now open, and work with your scanned data.
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Managing the Job Queues
After entering the IC-301 print controller, a job resides either in the 
queues or in the Storage area, depending on the job flow. 

There are two queues, Process and Print.

• The Process Queue lists the job that is currently being processed 
and the jobs that are waiting to be processed. 

• The Print Queue lists the currently printing job and the jobs that 
were processed successfully and are waiting to be printed. The 
Print Queue also lists held jobs —for example, jobs for which the 
specified paper stock is not available.

At any time, you can view information regarding the number and 
status of the jobs in the queues. You can also change the order of 
the jobs and suspend or resume the queue.

After you start the IC-301 print controller, the queues are 
displayed. 

 

Each queue holds jobs in the order in which they enter it. The top 
job in the queue is currently running, while all others are waiting to 
run. 

If necessary, you can change the order of the jobs that are waiting 
in the queues. You can also view and edit the jobs’ parameters.

Note:  If there are very short jobs in the Print Queue, several jobs may be 
printing at the same time. The jobs marked as printing are listed first and 
printed in the order they are listed.
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The Queues
After you submit PDL jobs (or resubmit PDL jobs), the Process 
Queue lists the files to be processed. 

Once a file has been processed successfully, it moves to the Print 
Queue and waits to be printed or to the Storage area (depending on 
the current job flow or virtual printer).

The queues list information about the jobs that are being 
processed. Status indicators indicate the status of each job. 
Table 4 describes the status indicators used in both the Process 

Queue and Print Queue.

For more information about operations on the jobs residing in the queues, 
see Aborting a Running Job on page 59.

Table 4: Process Queue and Print Queue status indicators

This 
Status 
Indicator

Indicates This

The job is printing or processing.

The job is on hold in the Print Queue. If a job is on 
hold, it indicates that the selected paper stock is 
not available
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You can add, remove, and reorder the columns in the Process 
Queue and in the Print Queue.

To add columns:

Right-click the column heading row, select Add and then select 
the column that you want to add. 

The column is added to the right of the selected column. 

To remove columns:

Similarly, you can remove columns in the Process Queue and in the 
Print Queue. Right-click the column heading row, select Delete, and 
then select the column you want to remove.

To reorder column headings:

In addition, you can change the order of the column headings. 
Right-click the column heading row, select Move and then select 
Left or Right. 

The job is waiting.

Table 4: Process Queue and Print Queue status indicators

This 
Status 
Indicator

Indicates This

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Status Current status of the job

Job Title Original name of the job and file 
extension—for example, Lizard.pdf

Owner User name of the system from which this 
file originated

Page Size Page size of the finished, trimmed 
document
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Status Information

The printing and processing status areas contain the following 
information:

• The suspend and resume buttons 

• The queue name.

• The number of jobs in the queue—for example, 2.

Submission time Date and time this job was first submitted 
to the IC-301 print controller

Pages Number of pages to be processed in a 
PDF job. If the DTP application supported 
it, the number of pages is indicated for 
other PDL jobs.

Copies Number of copies that were requested to 
be printed 

Time Passed Amount of time that has passed since job 
processing started

File Type File format of the PDL job—for example, 
PS (.ps), PDF(.pdf), VPS(.vps)

Media Type Media type defined in the job parameters 
window

Account Account name defined in the job 
parameters window

Color Mode Color mode defined in the job parameters 
window: grayscale or color

Comments Comments entered in the job parameters 
window

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:
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Suspending and Resuming Queues
If necessary, you can stop a queue temporarily and then later 
continue its operation afterwards. To do this, use the suspend and 

resume buttons:

To suspend a queue:

Click the suspend button .

The processing or printing stops after the current job has 
finished running.

To resume a queue:

Click the resume button .

The top job in the queue starts processing or printing.

Changing the Order of Jobs in the Queues 
You can rearrange the jobs in a queue to change the order in which 
they will be processed or printed. This feature is useful when you 
have an urgent job that takes priority, for example.

To move a job up in the queue:

Right-click the job and select one of the following options:

Promote: to move the job up one step

Promote to top: to move the job to the top of the queue

To move a job down in the queue:

Right-click the job and select one of the following options:

Demote: to move the job down one step

Demote to bottom: to move the job to the bottom of the 
queue.

Note:  The job is placed below the Printing or Processing job.
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Aborting a Running Job

To stop processing or printing a running job:

Right-click the running job in one of the queues, and from the 
menu, select Abort.

The job moves from the queue to the Storage area.

The Aborted status is assigned to the job, and the next job in 
the queue starts running.

To return a job to the Process Queue or Print Queue:

In the Storage area, right-click the job and select Submit.

Batching Jobs
The job-batching workflow combines jobs with similar attributes 
into a single batch to enable the printer to print the jobs 
continuously without pausing. This feature saves printing time, 
especially for a large number of small jobs. Jobs that use paper of 
the same size and weight are suitable for batching. 
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When a job enters the Print Queue, the IC-301 print controller 
checks whether the job is suitable for batching with the previous 
one: 

• A job that can be batched appears with the printing status 
indicator. The printer prints both jobs without pausing between 
them. All jobs that are batched are grouped together and 
highlighted.

• A job that cannot be batched with the previous one waits in the 
queue and appears with the waiting status indicator. It is printed 
only when the printer finishes the previous job and comes to a 
stop. 

The IC-301 print controller batches suitable jobs only if they are 
consecutive in the queue. Two jobs are not batched if a job that is 
not suitable comes between them in the queue.

The job batching option is active by default. 

To deactivate job batching:

In the Preferences window, select Print Queue Manager. 

Moving a Waiting Job to the Storage Area
To postpone processing or printing of one or more waiting jobs, 
use the Move to storage option.

To move a waiting job to storage:

For more information about job batching, see Print Queue Manager on 
page 146.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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1. Select the job in the Print Queue or Process Queue.

2. Right-click the job(s), and select Move to storage.

The job(s) move(s) from the queue to the Storage area and 
appears with a Waiting status. 

To return a held job from the Storage area to its original queue:

Right-click the job, and from menu select Submit.

The job moves from the Storage area to the appropriate queue .

Deleting a Job
Once you delete a job from the Process Queue, Print Queue, or 
Storage area, you need to resubmit it for processing and printing. 
To temporarily remove a job from a queue, use the Move to storage 
option (see Moving a Waiting Job to the Storage Area on page 60).

To delete a job:

1. Right-click the desired job in the queue or Storage area, and 
select Delete.

The following message appears.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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2. Click Yes.

The selected job(s) is deleted.

Managing the Storage Area

In the Storage area, you can see the number of jobs that are in 
storage, their status, and select one of the three views in the View 
list:

• List: Displays a list of all jobs in the Storage area

• Preview: Displays a list of all jobs and a thumbnail view of the 
selected job

• Gallery: Displays thumbnail of the first page of each job in the 
Storage area 

Note:  You can delete more than one job at a time: Select the jobs, and 
from the Job menu, select Delete.
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The Storage area contains jobs of various types:

• Printed jobs

• Jobs that you moved to the Storage area or aborted during 
processing or printing

• Jobs that failed during processing or printing

• Retrieved jobs

• Jobs that were imported directly to the Storage area from the 
client workstation (by selecting the Store option for the job flow)

Each job in the Storage area is assigned a status as shown in 
Table 6.

Handling Jobs in the Storage Area
In the Storage area you can perform the following actions:

• Submit a job. See Submitting Jobs on page 64.

• Archive a job. See Archiving and Retrieving Jobs on page 64.

• Delete a job. See Deleting a Job on page 61.

Table 6: Storage area status descriptions

Icon Status Indicates This

Completed The job has finished printing.

Waiting You moved the job from the 
queues to the Storage area; or the 
current job flow or virtual printer 
moved the job to the Storage area 
automatically.

Failed The job failed during processing 
or printing.

Aborted You aborted the job in the queues 
while the job was running.
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• Duplicate a job. See Duplicating Jobs on page 64.

• Preview a job, using the Job Preview. See Previewing a Job on 
page 67.

• View a job’s history (in the Job Log window). See Viewing the 
Job History Window on page 67.

• View the job report for a job. See Job Report on page 81.

• Go back to the original PDL file

• Export as PDF2Go. See Export as PDF2Go on page 95.

Submitting Jobs

To submit a job in the Storage area:

In the Storage area, right-click the job, and select Submit.

Processed jobs are submitted to the Print Queue; all other jobs 
are submitted to the Process Queue.

Duplicating Jobs

To duplicate a job:

1. In the Storage area, right-click the job and select Duplicate. 

The selected file is duplicated and is given the name of the 
original job followed by the suffix _dup.

Archiving and Retrieving Jobs
To keep enough disk space free, it is recommended that you back 
up jobs and their related files to an external server and then delete 
them from the Storage area.

This backup process is called archiving. You can retrieve archived 
jobs and related files later for further use.

Notes:

• Duplicating a processed job creates a PDL version of the job.

• Once you duplicate a job, you can only edit parameters in the Job 
Preview & Editor window that do not require re-RIP. 
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To archive a job on an external server:

Before you begin this procedure, make sure that you create a 
folder in which to store the archived jobs.

1. In the Storage area, right-click the job you want to archive and 
select Archive.

The Archive dialog box appears.

2. Find the desired folder, and then click Archive .

A cabinet file (a compressed file) that contains all the files 
related to the archived job is created at the selected location. 

3. Delete the job from the Storage area.

Notes:

• The archived job retains its current status (that is, completed, failed, 
held, or aborted) and is archived with the information in its job 
parameters and Job History windows. 

• When retrieved, the archived job retains the original job name, not 
the name assigned when archived.

• You can archive two or more files simultaneously.
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To retrieve an archived job:

1. From the File menu, select Retrieve.

The Retrieve dialog box appears.

2. Find the archived job under its archive name, and select the 
related cabinet file.

3. Click Add . 

The selected job appears in the lower list in the Retrieve dialog 
box.

4. Click Retrieve . 

The selected job appears at the top of the list in the Storage 
area. It is assigned the status that is had before archival. 

Notes:

• You can retrieve more than one job at a time.

• The files related to the job (for example, PDL) are also retrieved.

• The job is retrieved with the information in its job parameters and 
Job History windows.

• The cabinet file is not deleted.
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5. In the Message Viewer window, verify that the file has been 
successfully retrieved.

Viewing the Job History Window
In the Storage area, right-click the job and select Job History.

The Job History window appears.

Previewing a Job
The Job Preview & Editor window enables you to preview and edit 
an RTP job before it is sent to print. You can see all of the job 
details and verify the job quality and content. While you navigate to 
the various pages of a job, you can view thumbnails of the job. For 
an imposed job, you can view the imposed sheets, including the 
layout of the pages on each sheet. 

To open the Job Preview & Editor window:

In the Storage area, right-click an RTP job that you want to 
preview, and select Job Preview.

The Job Preview & Editor window appears, displaying the first 
page of the selected job.

Navigation Buttons

The navigation buttons  enable you to view the 
pages of the current job.

For more information about the Job History window, see Job History on 
page 149.

Note:  When the first page of a booklet is in view, the Previous Page 
navigation button takes you to the previous booklet. When the last page of a 
booklet is in view, the Next Page button takes you to the next booklet.
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Using the Preview Tools
The preview buttons enable you to switch the display mode of the 
page.

Table 7: Description of preview buttons

This button Enables you to

Pan

View a different area of the image

Eye Dropper

Find out the CMYK values of a specific area on the 
page. To find the values, first click the Eye Dropper 
button. Then move the pointer to the point on the 
page where you want to measure the color values 
and click. The CMYK density values and spot 
color values appear as a tool tip.

Zoom In

Magnify the selected area of the page. To return to 
the previous view, click the Zoom Out button.

Zoom Out

Reduce the size of the selected area of the page 
by 50%. To return to the previous view, click the 
Zoom In button.

One to One 

Zoom

View the actual size of the page one-to-one (1:1).

Fit to Screen

Scale the page to fit the available screen space.

View the image at different preset levels of 
magnification by selecting a percentage in the list. 

Rotate View

Rotate the page 90°, 180°, and 270°.

Show/Hide 

Separation

Turn on or off one or more separations
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Viewing Pages in the Job Preview & Editor Window
The Job Preview & Editor window has three tabs—Booklet, 
Thumbnails, and Imposed Sheets—which enable you to switch 
between views.

The Booklet Tab
The Booklet tab displays the booklets included in the selected job 
and the names and numbers of the pages in each booklet. The 
Booklet tab opens by default. To examine a specific page, double-
click the page you want to view on the left pane of the Booklet tab. 
The page is displayed on the right pane.

The Thumbnails Tab
The Thumbnails tab displays miniature views (“thumbnails”) of each 
page in the selected booklet. These thumbnails enable you to find 
a specific page more easily. To examine a specific page, double-
click the page you want to view on the left pane of the Thumbnails 

tab. The page is displayed on the right pane.
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The Imposed Sheets Tab
The Imposed Sheets tab displays imposed RTP jobs. This tab 
enables you to view the imposed sheets and check your imposition 
parameters. 
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Editing an RTP Job
You can edit an RTP job in the following ways:

• Move pages within the job

• Delete pages from the job

• Insert pages from another job

To move a page in a job:

1. Click the Thumbnails tab. 

2. In the Thumbnail pane, click the page that you want to move.

3. Drag the page to the target location. 

The page moves to the selected location, and the page 
numbers are updated accordingly.

Note:  Jobs that you can edit in the Job Preview & Editor window can’t be re-
RIPed. Once a job has been saved in the Job Preview & Editor window, it is a 
new RTP file without an associated PDL file. You can’t apply parameters that 
require re-RIPing to such jobs.

Note:  The red marker indicates where the page will be inserted.
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4. Click Save As to save the changes in the job.

To delete a page from a job:

1. In the Job Preview & Editor window, click the page that you 
want to delete, and click Remove.

2. Click Save As to save the changes.

Copying Pages Into a Job
You can copy one page or all pages from one job to another.

To copy a page into a job:

1. In the Job Preview & Editor window, open the job that you want 
to edit.

2. Click Merge Job .

The RTP Jobs window appears.

3. Select the job that includes the page you want to copy, and 
then click OK.

The thumbnails of the second job appear in a separate window.

Note:  The IC-301 print controller displays only those RTP jobs that the 
same page size and orientation as the job that you are editing.
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4. Find the page you want to copy, and then drag the page to the 
target location in the job that you are editing.

The copied page is inserted in the desired location, and the 
page numbers are inserted accordingly.

To copy all the pages of a job into another job:

1. In the Job Preview & Editor window, open the job that you want 
to edit.

2. Click Merge Job.

The RTP Jobs window appears.

3. Select the job that you want to merge, and then click OK.

The thumbnails of the second job appear in a separate window.

Note:  The red marker indicates where the page will be inserted.
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4. Click Merge All , and then click Close.

All of the pages from the second job that you opened are 
inserted at the end of the job that you are editing.

5. Click Save As to save your changes.

Job Accounting
The Accounting Viewer window provides information about all of 
the jobs that were printed successfully via the IC-301 print 
controller. By default, all of the jobs that were handled during the 
past 90 days are listed. The report is in the form of a tab-delimited 
file. You can filter, sort, and print the jobs in the report and also 
export the report to a spreadsheet application—for example, 
Microsoft Excel—where you can manipulate the data.

Viewing the Accounting Information
From the Info menu, select Accounting.

The Accounting Viewer window appears, and lists information 
related to all the jobs that printed successfully via the IC-301 
print controller. 
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Each row in the accounting report contains information related to a 
specific job.

The columns indicate the following information.

Note:  To see additional columns, use the horizontal scroll bar.

Table 8: Description of columns in the Accounting Viewer

Column name Indicates the

 Title Original name of the file 
related to this job (that is, 
without the extension)

Type Type of job, scan or print

Job Size Job size in MB

Sender User name of the system from 
which this job originated

Started Process Date and time in which the job 
first started processing

Processing Time Total time during which the job 
was processed
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Started Printing Date and time in which the job 
first started printing

Printing Time Total time during which the job 
was printed

Paper Size Size of the media set for the 
job—for example, Letter, A3, 
A4

Media Type Paper type

Weight Paper weight in gs/m

B/W Pages Number of black-and-white 
pages in the original PDL file 

Color Pages Number of color pages in the 
original PDL file 

Blank Pages Number of blank pages, 
inserts, or interleaves in the 
original PDL file

Total Pages Number of pages that were 
printed

Account [Optional] string of text, if such 
was entered in job parameters 
window

Recipient [Optional] string of text, if such 
was entered in job parameters 
window

Job Comments [Optional] string of text, if such 
was entered in job parameters 
window

Table 8: Description of columns in the Accounting Viewer

Column name Indicates the
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Printing and Exporting the Accounting Log
You can save the accounting information to an ASCII Tab delimited 
file.

To export the accounting information:

1. In the Accounting Viewer window, filter the information as 
desired.

2. Click Export.

The Export dialog box appears.

‘

3. Find the folder in which to save the report.

4. Click Export.

The accounting log is saved as a Tab delimited text file in the 
specified location. 

Notes:

• The accounting log includes all the columns (even those that were 
hidden), listed in the original order and sorting.

• To export specific rows, select them before you click Export. The 
exported accounting log will include only these rows.

• The exported data is not deleted from the accounting report on the 
IC-301 print controller (that is, it will still be displayed in the 
Accounting Viewer window).
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5. If desired, open the *.txt file in a text editor or in a spreadsheet 
application—for example, Microsoft Excel—and manipulate 
the data.

You can print the accounting information (filtered and sorted) to 
any connected printer.

To print the accounting log:

1. In the Accounting Viewer window, filter and sort the report as 
desired.

2. Click Print List.

The Print window appears.

3. Set the printing options as desired and click OK.

The data is printed according to the current filtering and 
sorting.

Note:  To print specific rows, select the desired rows now. The printed 
report will include only these rows.

Notes:

• To fit the maximum amount of columns on the page, print using 
Landscape orientation (if your printer supports it).

• The report includes all the columns (including those that were 
hidden), listed in the original order.
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Creating Virtual Printers
The IC-301 print controller is predefined with three virtual printers:

• Print 
Files sent to this printer are automatically processed and 
printed to the printer through the IC-301 print controller.

• Process 
Files sent to this printer are automatically processed and stored 
in the Storage area of the IC-301 print controller. You can later 
submit the jobs to be printed, or change the parameters of a 
job and resubmit it for processing.

• Store

Files sent to this printer are automatically stored in the IC-301 
print controller's Storage area until the print operator submits 
them for processing and printing.

When you add a new virtual printer, you can specify if it is 
published on the network and if the parameters of the virtual printer 
will override the PPD parameters.

If a job that is either sent from the client or downloaded to a 
particular virtual printer contains preset parameters from the PPD 
file, these options overwrite the parameters set in the virtual printer 
for that job. The printer default options defined in the PPD file use 
the default parameters set for that particular virtual printer.

To create a new virtual printer:

1. From the Tools menu, select Resource Center.

The Resource Center opens.

2. In the Resource list, select Virtual Printers.

3. Click Add.

The Add Virtual Printer dialog box appears.
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4. In the Name box, type a name for the new printer you want to 
add.

5. From the Based on list, select an existing printer with similar 
settings.

6. The Publish on the network check box is selected by default. 
Clear the check box if you do not want to publish the printer 
on the network. 

7. Select the Override PPD parameters check box if you would like 
the virtual printer settings to override the parameters set in the 
PPD file.

8. In the Comments box, type any comment regarding the virtual 
printer parameters (optional).

9. Click the Edit button to edit the job parameters of your new 
virtual printer. 

10. Click OK in the Add Virtual Printer dialog box. 

The new printer appears in the Printer list.

Note:  If you don't edit the job parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.
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Job Report
The Job Report window contains all of the information from the job 
parameters window (including job parameters window title bar 
data). The Job Report window displays the job parameters on a 
single sheet and may be exported or printed as a hard copy.

This feature is useful for:

• Retaining job parameters when the same job is planned to be 
re-printed in the future.

• Providing the client/customer a follow-up tool regarding printed 
job parameter information.

To open the Job Report window:

1. Right-click a job in the Storage area, and from the menu select 
Job Report.

2. Click Print or Export to print or export the report as a text file.
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Imposition 
Imposition is the process of positioning page images on a virtual 
sheet of paper so that when a printer or digital printing press prints 
the sheet, the page images will be in the right order. It is part of the 
process of producing finished documents.

In addition to page images, you can add various marks to the 
sheets to aid the production process. These marks show where the 
paper should be folded or trimmed.

Imposition does not affect the content of the individual page but 
rather affects only the placement of the page images on a press 
sheet. Imposition is a combination of content and layout. The 
content is the pages that should be printed, and the layout is the 
location of the page on the sheet, along with the page’s printing 
marks, crop marks and fold marks.

Imposition Workflows
The two examples in this section are typical imposition workflows. 
The first example shows you how to print business cards, and the 
second example shows you how to print a brochure. 

Printing Business Cards
This example demonstrates how to use the repeat-image 
imposition method to print business cards. With the repeat-image 
method, you can print multiple copies of the same image on one 
large sheet. 

In this example, the job contains business cards that are 50 mm × 
90 mm (2 in. × 4 in.), imposed on A3 paper.

1. Click the suspend button to temporarily stop the Process Queue.

2. Click Import to open the Import window.

3. Import your business card file. 

The file is imported to the Process Queue with a Waiting status.

4. Double-click the business card file in the Process Queue. 

The job parameters window appears.
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5. Click Imposition. 

6. For Imposition Method, select Step & repeat.

7. Click Size, and select the following options:

a. In the Sheet size list, select A3.

b. In the Trim size list, select Custom and then type the custom 
size in the height and width boxes—for example, 50.0 mm 
× 90.0 mm. 

c. In the Trim orientation list, select Landscape.
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8. Click Templates, and select the following options:

a. In the Columns list, select 5.

b. In the Rows list, select 4.

c. In the Print method list, select Simplex.
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9. Click Spacing.

10. In the Marks list, select Crop marks.

Note:  Gutter is automatically set to 6 mm.
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A preview of the template layout appears, showing you 
whether the pages fit on the sheet. If there are conflicts, they 
are indicated in the following manner: 

• Red corners: The trim size is bigger than the sheet size.

• Yellow corners: The margin settings are not suitable for your 
paper size.

• Dotted lines: The trim size and template settings conflict—
for example, A3 trim size for a repeat-image 2×2 duplex 
template.

11. Click Submit, and then click the resume button to start 
processing the job.

The business cards are printed imposed on A3 paper. 
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Printing a Brochure
This example demonstrates how to use the saddle stitch 
imposition method to print a brochure on the IC-301 print 
controller. The saddle- stitch method arranges the page images on 
the sheets so that when the sheets are printed, you can take the 
sheets out of the printer, fold them, and staple them in the center. 
In this example, the job contains ten letter-size pages imposed on 
tabloid paper. 

1. Click the suspend button to temporarily stop the Process queue. 

2. Click Import to open the Import window.

3. Import your brochure file. 

The file is imported to the Process Queuewith a Waiting status.

4. Double-click the brochure file in the Process Queue. 

The job parameters window appears.

5. Click Imposition. 

6. For Imposition Method, select Saddle stitch.
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7. Click Size, and set the following options:

a. In the Sheet size list, select Tabloid (11 × 17).

b. In the Trim size list, select Letter (8.5 × 11).

8. Click Templates, and select the following options:

a. In the Columns list, select 1.

b. In the Rows list, select 2.

c. In the Print method list, select Duplex HTH rotated. 
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9. Click Submit, and then click the resume button to start 
processing the job.

The brochure is printed imposed on tabloid paper, and is ready 
for folding and finishing with a staple in the center pages. 

You can use an IC-301 print controller virtual printer to predefine 
your imposition settings. When you create a new virtual printer or 
edit an existing one, define the imposition settings for that 
particular printer. These settings become the printer's default 
options and are applied to all jobs that use the printer. 

For more information about setting parameters in Imposition, see Imposition 
on page 159.

For more information about adding virtual printers, see Creating Virtual 
Printers on page 79.
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Printing with Page Exceptions
Page exceptions enable you to select a different media type for 
specific pages within your job. The example in this section uses the 
brochure from the imposition workflow ( see Printing a Brochure on 
page 89) to print a cover with a different paper weight. 

1. Make sure that the tray contains tabloid paper that is heavier 
than the paper needed for the rest of the job.

2. In the workspace, verify which tray contains the heavy paper.

3. In the Storage area, double-click the processed brochure job.

The job parameters window appears.

4. Click Exceptions, and perform the following steps:

a. In the Type list, select Cover.

b. Select the Duplex check box.

c. In the Tray list, select the tray with the tabloid paper that has 
the heavy paper—for example, Tray 1.

d. Click Apply, and then click Submit. 

Note:  This job contains the imposed settings that you set in the previous 
example.

Note:  The options in the Type list are different when the imposition 
method is saddle stitch. 
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The brochure is printed with a tabloid-size cover on heavy 
paper.

For more information about setting parameters in the Exceptions area, see 
Exceptions on page 174. 
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High-Resolution Workflow
Working with high-resolution files during the design and page 
layout process can often times be long and inefficient. Processing 
and manipulating large files and graphics can be very time 
consuming. To speed up production, it is common to work with 
low-resolution files until the RIPing stage.

The IC-301 print controller provides Creo APR (Automatic Picture 
Replacement) and supports Open Prepress Interface (OPI) image 
replacement workflows for replacing low-resolution files with high-
resolution files during the RIP. 

Creo APR
Creo APR is an image replacement method for PostScript files. 
Creo APR is a standardized set of file instructions that specify how 
an external high-resolution image is placed in a PostScript file as it 

High-Resolution Image File, 5.23 MB Low-Resolution Image File, 306 KB
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goes to RIP. The instructions specify the type, size, position, 
rotation, cropping and location of the high-resolution images 
themselves. 

When you send your PostScript file to be processed, the IC-301 
print controller checks it for Creo APR instructions. It then 
searches for the external high-resolution file, performs the 
specified image replacement and RIPs the PostScript file.

Export as PDF2Go
PDF2Go is a port through which you can export RTP and PDL files, 
and convert them to a PDF file during export.

The IC-301 print controller is capable of exporting jobs that are 
standard PDF files, both before and after processing. For an 
exported RTP job, the PDF file includes the rasterized data of the 
job.

The operation converts the RTP information to raster files that can 
be encapsulated in a PDF format. This process ensures that the file 
can be processed and printed on any PDF printer. 

To export as PDF2Go:

Select one of the following options:

• Print Optimized: Generates a high-resolution PDF file in 
300dpi. 

• Screen Optimized (default): Generates a low-resolution PDF 
file in 72 dpi. 

For more information about setting a high-resolution path and selecting high-
resolution or low-resolution images, see APR/OPI on page 177.

Tip:  Use the Screen Optimized option when you want to generate a light 
PDF file—for example, a file that you can send as a proof by e-mail.
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Fonts
This section lists all the fonts available on the IC-301 print 
controller, and explains how to work in the Fonts area of the 
Resource Center. 

A step-by-step procedure explains how to use the Adobe® 
DownLoader driver to download fonts from a Macintosh client 
workstation.

You can download Windows fonts from a client workstation to the 
IC-301 print controller. 

Font List
The fonts listed alphabetically in this section are the standard fonts 
that are available on the IC-301 print controller server.

AdobeSansMM AdobeSerifMM AlbertusMT

AlbertusMT-Italic AlbertusMT-Light AntiqueOlive-Bold

AntiqueOlive-Compact AntiqueOlive-Italic AntiqueOlive-Roman

Apple-Chancery Apple-ChanceryCE Arial-BoldItalicMT

Arial-BoldMT Arial-ItalicMT ArialCE

ArialCE-Bold ArialCE-BoldItalic ArialCE-Italic

ArialMT AvantGarde-Book AvantGarde-BookOblique

AvantGarde-Demi AvantGarde-DemiOblique AvantGardeCE-Book

AvantGardeCE-BookOblique AvantGardeCE-Demi AvantGardeCE-
DemiOblique

Bodoni Bodoni-Bold Bodoni-BoldItalic

Bodoni-Italic Bodoni-Poster Bodoni-PosterCompressed

Bookman-Demi Bookman-DemiItalic Bookman-Light

Bookman-LightItalic BookmanCE-Demi BookmanCE-DemiItalic

BookmanCE-Light BookmanCE-LightItalic Carta

Chicago ChicagoCE Clarendon

Clarendon-Bold Clarendon-Light CooperBlack
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CooperBlack-Italic Copperplate-ThirtyThreeBC Copperplate-ThirtyTwoBC

Coronet-Regular CoronetCE-Regular Courier

Courier-Bold Courier-BoldOblique Courier-Oblique

CourierCE CourierCE-Bold CourierCE-BoldOblique

CourierCE-Oblique EuroMono-Bold EuroMono-BoldItalic

EuroMono-Italic EuroMono-Regular EuroSans-Bold

EuroSans-BoldItalic EuroSans-Italic EuroSans-Regular

EuroSerif-Bold EuroSerif-BoldItalic EuroSerif-Italic

EuroSerif-Regular Eurostile Eurostile-Bold

Eurostile-BoldExtendedTwo Eurostile-ExtendedTwo Geneva

GenevaCE GillSans GillSans-Bold

GillSans-BoldCondensed GillSans-BoldItalic GillSans-Condensed

GillSans-ExtraBold GillSans-Italic GillSans-Light

GillSans-LightItalic Goudy Goudy-Bold

Goudy-BoldItalic Goudy-ExtraBold Goudy-Italic

Helvetica Helvetica-Bold Helvetica-BoldOblique

Helvetica-Condensed Helvetica-Condensed-Bold Helvetica-Condensed-
BoldObl

Helvetica-Condensed-Oblique Helvetica-Narrow Helvetica-Narrow-Bold

Helvetica-Narrow-BoldOblique Helvetica-Narrow-Oblique Helvetica-Oblique

HelveticaCE HelveticaCE-Bold HelveticaCE-BoldOblique

HelveticaCE-Cond HelveticaCE-CondBold HelveticaCE-CondBoldObl

HelveticaCE-CondObl HelveticaCE-Narrow HelveticaCE-NarrowBold

HelveticaCE-
NarrowBoldOblique

HelveticaCE-NarrowOblique HelveticaCE-Oblique

HoeflerText-Black HoeflerText-BlackItalic HoeflerText-Italic

HoeflerText-Ornaments HoeflerText-Regular HoeflerTextCE-Black

HoeflerTextCE-BlackItalic HoeflerTextCE-Italic HoeflerTextCE-Regular

JoannaMT JoannaMT-Bold JoannaMT-BoldItalic

JoannaMT-Italic LetterGothic LetterGothic-Bold
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LetterGothic-BoldSlanted LetterGothic-Slanted LubalinGraph-Book

LubalinGraph-BookOblique LubalinGraph-Demi LubalinGraph-DemiOblique

Marigold Monaco MonacoCE

MonaLisa-Recut NewCenturySchlbk-Bold NewCenturySchlbk-
BoldItalic

NewCenturySchlbk-Italic NewCenturySchlbk-Roman NewCenturySchlbkCE-Bold

NewCenturySchlbkCE-
BoldItalic

NewCenturySchlbkCE-Italic NewCenturySchlbkCE-
Roman

NewYork NewYorkCE Optima

Optima-Bold Optima-BoldItalic Optima-Italic

Oxford Palatino-Bold Palatino-BoldItalic

Palatino-Italic Palatino-Roman PalatinoCE-Bold

PalatinoCE-BoldItalic PalatinoCE-Italic PalatinoCE-Roman

StempelGaramond-Bold StempelGaramond-
BoldItalic

StempelGaramond-Italic

StempelGaramond-Roman Symbol Tekton

Times-Bold Times-BoldItalic Times-Italic

Times-Roman TimesCE-Bold TimesCE-BoldItalic

TimesNewRomanPS-
BoldItalicMT

TimesNewRomanPS-
BoldMT

TimesNewRomanPS-
ItalicMT

TimesNewRomanPSMT Univers Univers-Bold

Univers-BoldExt Univers-BoldExtObl Univers-BoldOblique

Univers-Condensed Univers-CondensedBold Univers-
CondensedBoldOblique

Univers-CondensedOblique Univers-Extended Univers-ExtendedObl

Univers-Light Univers-LightOblique Univers-Oblique

Wingdings Wingdings-Regular ZapfChancery-MediumItalic

ZapfChanceryCE-MediumItalic ZapfDingbats
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Managing Fonts on the IC-301 Print Controller

1. On the toolbar, click Resource Center  . 

2. In the Resource list, select Fonts.

To set the default font:

Select a font from the list and click Set as Default.

To delete a font:

Select the font, and click Delete font.

To add new fonts:

Copy the new fonts to the C:\IC-301\General\RIP\fonts folder.

Downloading Fonts 

Downloading Fonts in a Macintosh Network
The Downloader driver enables you to download fonts from a 
Macintosh client workstation. The driver functions as a 
communications port and sends messages between the driver and 
the IC-301 print controller. Through the Downloader driver, you can 
only send fonts.



100  Chapter 6– Production Printing

To download fonts from Mac OS 9

1. From the Apple menu, select Chooser.

2. Select AppleShare and find the IC-301 print controller.

3. Select the IC-301 print controller—for example, IC-301—and 
then click OK. The Login dialog box appears.

4. Log in as Guest, and click the Connect button.

The corresponding IC-301 print controller window appears.

5. Select the Utilities folder, and then click OK.

6. Double-click the Adobe Downloader 5.0.5 folder. 

7. Copy the Adobe Downloader 5.0.5 to your desktop.

8. From the Apple menu, select Chooser.

The Chooser window appears.

9. Select LaserWriter (8.x) and select the desired fontdownloader.

10. Click Create.

11. Double-click the Downloader 5.05 on your desktop.

12. On the File menu, select Download Fonts.

Note:  Mac OS 10 users that want to download fonts need to use a 
previous Mac OS version—for example, Mac OS 9. It is recommended 
that you embed the fonts in your file.

Note:  Do not select the check box, otherwise it will mount every time you 
restart.
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13. In the Fonts list, select the desired font folder.

14. Verify that the selected device is Disk 0.

15. Add all the desired PostScript fonts and click Download.

Downloading Fonts in a Windows Environment

You can use the HF_Fontdownloader hot folder to install new or 
missing fonts to the IC-301 print controller fonts dictionary. The hot 
folder is located in D:\HotFolders and can be used with the following 
operating systems:

• Windows NT 4.0

• Windows 2000

• Windows XP 

• Windows 2003

To download Windows fonts:

Drag the fonts from your client workstation to the 
HF_Fontdownloader hot folder.
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Calibration
One of the most important issues in obtaining satisfactory print 
quality is steady toner density. Toner density is affected by many 
factors such as heat, humidity, and service settings. You should 
perform calibration every 24 hours to compensate for these 
factors. 

The calibration process corrects the printer colors by measuring 
their density and creating calibration look-up tables. The IC-301 
print controller uses the data in these tables to compensate for the 
differences between the actual, measured density level and the 
target level, the target density.

You should perform calibration in the following instances:

• When prints show “color casts”

• After machine maintenance or hardware changes—for 
example, replacing a “Charge Coroton”

• On drastic ambient changes (temperature and humidity)

Color Calibration Method
The IC-301 print controller uses the target calibration method. This 
method ensures consistency over time and that the density values 
of the printed output do not exceed the predefined density values.

Target calibration enables you to calibrate the bizhub PRO C500 
printer according to the following predefined density values:

Table 9: Fixed density values for uncoated paper

Toner Density value

Cyan 1.35

Magenta 1.365

Yellow 0.934

Black 1.7
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Choosing a Calibration Mode
The IC-301 print controller provides you with two calibration 
modes:

• Off-the-glass: Uses the scanner platen to perform off-the-glass 
calibration

• Densitometer: Uses the DTP34 densitometer, which is a “high 
speed”color measurement instrument, to report densitometer 
and dot data

You select the calibration mode in the Preferences window, see 
Calibration Device on page 148.

Calibration Process
This section describes the off-the glass calibration process. If you 
want to use the DTP34 densitometer to calibrate, refer to the X-Rite 
DTP34 Densitometer Operator’s Manual and follow the IC-301 
print controller calibration wizard

Table 10: Fixed density values for coated paper

Toner Density value

Cyan 1.6

Magenta 1.66

Yellow 1.054

Black 1.8

Note:  It is recommended that:

1. After you perform the first calibration, you print the IQ_Test_(TAB/A3).pdf 
file from the D:\Sample_Files\(USA/Europe)\IQ Files folder. Each time 
you calibrate, use this file as a visual reference to verify that the printer has 
returned to its start point. 

2. You calibrate both the printer and scanner at the same time. If you only 
place the print chart on the platen, the printer is calibrated. If you only place 
the scanner chart on the platen, the scanner is calibrated.
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1. On the toolbar, click Calibration.

The Calibration Wizard appears.

2. In the Tray list, select the desired tray. The default is Tray 1. You 
can print the calibration chart on any paper size that is equal to 
or larger than A4 or Letter.

3. In the Media Type list, select the desired media type—for 
example, Coated. The default setting is Use Printer Settings. 
When this option is selected, your job is printed on the media 
type that is defined on the bizhub PRO C500 printer.

4. If you want a glossy look applied to your printed outputselect 
the Gloss Mode check box.

5. In the Number of copies box, enter the number of copies you 
want to print.

6. Click Print. 

The calibration chart prints.

7. Click Next. 
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8. Place both the printer and scanner charts next to each other 
on the platen and follow the instructions in the Calibration 
Wizard. 

9. When the last chart is successfully measured, click Finish to 
save the new calibration. 

2. 

Note:  If the calibration chart is not placed within the defined scanning 
area on the platen, the calibration process may not be successful. To 
ensure that the calibration process is successful, on the bizhub PRO 
C500 printer, press HDD>Calibration>OK. Then, press Size 

Settings>Full Area Size. 
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Color Tools 
The IC-301 print controller provides you with a number of tools and 
options that enable you to adjust and improve the color quality in 
your jobs. The following tools are available:

• Profile Manager, in which you can manage source and 
destination ICC profiles, see Managing Profiles on page 108

• Spot Color Editor, see Editing and Creating Spot Colors on 
page 111

• Gradation Tool window, see Using the Gradation Tool to Adjust 
Color on page 114

Managing Profiles
The Profile Manager window enables you to import and delete 
source and destination ICC profiles.

Source profiles are used to emulate other devices, or color spaces. 
You can import source CMYK or RGB profiles. 
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Destination profiles define the color space of your printer and are 
based on the combinations of paper and toner that you are using. 
For different media types, you need different destination profiles. 
Each custom destination profile will be used with coated and 
uncoated paper. 

To import a source ICC profile:

1. On the toolbar, click Resource Center . 

The Resource Center appears.

2. In the Resource list, select Profile Manager.

The Source Profile tab displays the predefined source ICC 
profiles.

3. Click Add .

The Import Source ICC Profile dialog box appears.

For more information about selecting source and destination profiles in a job, 
see Color on page 166.
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4. In the Source profile area, click the browse button . Locate 
and select the required source profile, and then click Open.

The new emulation name is displayed in the Emulation name 
box; if you would like to change the name you may do so.

5. Click Import.

The new source ICC profile is added to the Color Flows tab in 
the job parameters window.

To import a destination ICC profile:

1. In the Resource Center>Profile Manager, click the Destination 

Profile tab.

The predefined ICC profiles are displayed.

2. Click Add .

The Import Destination ICC Profile dialog box appears.
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3. In the Destination profile area, click the browse button . 
Locate the required source profile, and then click Open.

The new emulation name is displayed in the Destination Name 
box; if you would like to change the name you may do so.

4. Click Import.

To delete an ICC Profile:

1. In the Resource Center>Profile Manager, select the profile that 
you want to delete.

2. Click the Remove button .

The profile is deleted from the profile list.

Editing and Creating Spot Colors
Individual job pages can contain continuous tone (CT), line work 
(LW), and spot color elements. The IC-301 print controller Spot 
Color Editor enables you to edit the CMYK values of every spot 
color in the Spot dictionary. You can edit these values without 
affecting the CT or LW page elements. The Spot Color Editor also 
enables you to create custom spot colors and to define fixed 
CMYK values for those spot colors. The IC-301 print controller 
supports HKS and PANTONE 2000 spot colors.

Note:  You cannot delete predefined ICC profiles.

Note:  Spot colors—for example Pantone—are not affected by CMYK 
emulation. A spot color has the same appearance with any selected CMYK 
emulation.
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To edit an existing pantone color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor dialog box appears with the IC-301 print 
controller's entire collection of colors listed.

2. To search for a specific color, perform one of the following 
actions:

• In the Color list, search for a particular color. .

• In the Spot dictionary list, select the color dictionary that 
contains the color you want to edit.

3. Highlight the required color. 

The color's CMYK values and a color preview appear in the 
right hand side of the Spot Color Editor dialog box.

4. Change the CMYK values as required.

Note:  You cannot perform an exact query in the Color list. This input 
stream only reads one character. For example, if you want “Cool 
Grey 4” and type “Cool”, as soon as you type “C”, the cursor only 
moves to “Cool Grey 1” and does not continue to a more specific 
selection. 

Note:  Use the PANTONE CV dictionary if you are working in—for 
example, QuarkXPress.
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5. Click Apply. 

The new color is added to the Custom color dictionary.

To create a new spot color:

1. In the Spot Color Editor dialog box, click Add.

2. Type the new color name as it exists in the PostScript file. 

3. Adjust the CMYK values as required.

4. Click Save. 

The new color is added to the Custom Dictionary.

To delete a spot color (from the custom dictionary only):

1. In the Spot dictionary list, select Custom Dictionary. 

2. From the list of custom colors, highlight the color you wish to 
delete.

3. Click Remove.

The following message appears.

Note:   If you create a new spot color for an RTP job, perform the following steps 
before printing:

1. Revert back to the original PDL file.

2. Re-RIP the job.

Note:  The spot color names are case sensitive and should match the 
name as it appears in the DTP application.
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4. Click Yes to delete the color. 

Using the Gradation Tool to Adjust Color 
Sometimes you need to perform tone corrections when you print a 
job. The IC-301 print controller enables you to create a gradation 
table that will correct your printed output. Changes in gradation 
can include brightness, contrast, and color balance adjustments 
throughout the tone range of an entire image or in specific tone 
ranges. 

The Gradation Tool window enables you to create and edit 
gradation tables as well as visually check the effect of your 
gradation tables on a specific processed job. The new gradation 
tables you create are added to the Gradations list in the Color 
parameter and can be applied to print jobs. 

To open the Gradation Tool window:

From the Tools menu, select Gradation.

The Gradation Tool window appears.

Previewing a Job
1. Click the Browse button next to the Preview File list.

The Processed Jobs dialog box appears. The jobs that are 
displayed are the jobs listed in the Storage area.

For more information about selecting gradation tables in the Color 

parameter, see Gradation on page 168.
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2. Select the job that you want to preview, and then click Open. 

The Original and Edited views display your job. 



116  Chapter 7– Color Workflow

Editing Gradation Tables
When you open the Gradation Tool window, the default gradation 
table, DefaultTable, is selected in the Gradation Table list, and is 
displayed in the graph. This table serves as a baseline and consists 
of a 45° gradation curve, with Brightness and Contrast set to 0, and 
Contrast Center set to 50. All of the color separations are selected. 

The Gradation Table list includes four other predefined gradation 
tables:

• Cool: Blue tones appear clearer

• Lively: Increases the color saturation

• Sharp: Increases the contrast

• Warm: Sets the hues in the low densities to a bright reddish 
color 

Gradation tables that you create or edit also appear in the 
Gradation Table list. When you select a gradation table, the 
predefined settings are immediately applied to the processed job 
that you are working with.

The Separations buttons enable you to select one, all, or any 
combination of separations to edit for a specific gradation table. 
Selecting a specific separation enables you to change the color 
balance for a specific tonal range.

When you open the Gradations Tool window, all of the separations 
are selected. 

1. Click the All Colors button  to edit all the separations 
simultaneously. 

2. Click the individual separations you wish to edit—for example, 
select the cyan separation only
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3. Click the curve in the graph to add a point, and then drag the 
point to modify the separation. When you select a point, its 
value appears in the Input or Output boxes.

The Input axis represents the tone values of the image before 
gradation changes. The Output axis represents the tone values 
of the image after gradation changes.

4. To view gradation changes in your job, click Refresh. Changes 
are automatically applied to the displayed image in the After 
view.

5. To remove a point on the curve, select the point and then click 
Remove.

6. To reset the gradation curve to a 45° curve, click Reset .

7. To revert to the original gradation settings, click Revert .

8. To remove the last change you made to the gradation graph, 
click Undo.

Creating a New Gradation Table
1. In the Gradation Tool window, modify your gradation table as 

required.

2. Click Save . 

3. In the Table name box, type the required name for the new 
gradation table. 

4. Click OK. 

The gradation table is saved and added to the Gradation Table 
list and to the Color Modes tab in the job parameters window.
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Deleting a Gradation Table
Select the gradation table, and then click Remove.

Navigation Buttons

The navigation buttons  enable you to view the 
pages or booklets of the current job.

Using the Preview Tools
The preview buttons enable you to switch the display mode in the 
Original and Edited views.

Note:  You cannot delete predefined gradation tables.

Table 11: Description of preview buttons

This button Enables you to

Eye Dropper

Find out the CMYK values of a specific area on the 
page. To find the values, first click the Eye Dropper 
button. Then move the pointer to the point on the 
page where you want to measure the color values 
and click. The CMYK density values and spot 
color values appear as a tool tip.

Pan

View a different area of the image

Zoom In

Click an area of the page to magnify the area. To 
return to the previous view, click the Zoom Out 
button.

Zoom Out

Click an area of the page to reduce the size of the 
page by 50%. To return to the previous view, click 
the Zoom In button.

One to One 

Zoom

View the actual actual size of the page one-to-one 
(1:1)
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Brightness and Contrast Slider Controls
The Brightness and Contrast slider controls are active only when all 
of the separations are selected.

Fit to Screen

Scale the page to fit the available screen space

View the image at different preset levels of 
magnification by selecting a percentage in the list 

Rotate View

Rotate the page 90°, 180°, and 270°

Show/Hide 

Separation

Turn on or off one or more separations

Original/

Edited view

Toggle between the Original and Edited views

Original/

Edited view

View the Original and Edited views in portrait

Original/

Edited view

View the Original and Edited views in landscape

Table 11: Description of preview buttons

This button Enables you to
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Brightness

The Brightness slider increases or decreases the luminance of the 
image. Increasing brightness brightens the image and results in a 
concave curve. Decreasing brightness darkens the image and 
results in a convex curve. 

Move the Brightness slider to the right to increase brightness or 
to the left to decrease brightness.

Contrast

The Contrast slider increases the image contrast by making the 
highlights lighter and the shadows darker. It can also be used to 
decreases the contrast.

Move the Contrast slider to the right to increase contrast (S 
shaped curve), or to the left to decrease contrast (inverted S 
shaped curve).

Contrast Center

The Contrast Center slider increases the image contrast mainly in 
the midtones. Using Contrast Center, you can adjust where the 
contrast is increased. To enhance contrast in highlights, the 
Contrast Center is shifted toward the highlights. To enhance 
contrast in shadows, the Contrast Center is shifted toward the 
shadows.

Set the Contrast Center slider to the right to enhance contrast in 
highlights, or to the left to enhance contrast in shadows.

Your change affects the gradation graph by moving the point 
where the curve changes from convex to concave.

Note:  Contrast Center only affects the image if Contrast has also been 
adjusted.
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VI Overview
Variable information (VI) jobs are jobs in which the printed materials 
are individualized for specific recipients or purposes. These 
materials can include bills, targeted advertising, and direct 
mailings.

VI jobs are composed of booklets, which are personalized copies 
of a document. A booklet can consist of one or several pages, but 
the entire document is targeted at a specific individual or address. 
For example, a booklet can be either a single-page gas bill or a 
multipage personalized document.

Each page in the booklet is constructed as a collection of 
individually RIPed elements that may differ from booklet to booklet, 
including text, graphics, pictures and page backgrounds. These 
elements are self-contained graphical entities that may be line art, 
text, RIPed images, or a combination of these. There are two types 
of elements in VI jobs:

• Unique elements are used only once for a specific individual or 
purpose. An individual’s name is an example of a unique 
element.

• Reusable VI elements can be used more than once in different 
pages, booklets, or jobs. A company logo is an example of a 
reusable element.

Pages are assembled from the pre-RIPed reusable elements and 
the RIPed unique elements just before printing. Then the job is 
printed in the same way as all other jobs
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VI Document Formats
VI jobs are created using VI authoring programs that support 
Variable Print Specification formats. Most VI authoring programs 
can convert VI files to conventional PostScript files, which can also 
be processed by the IC-301 print controller, although less 
efficiently than Variable Print Specification files. Each authoring 
program creates VI code that instructs the RIP where to place the 
VI elements and each authoring program does so in a slightly 
different manner.

The format you choose can be a stand-alone format that covers all 
aspects of document design, data management and text capture 
or it can be an extension of an existing program that enables the 
creation of VI documents and VI jobs.

The IC-301 print controller can process VI jobs that are in one of 
the following file formats:

• Creo Variable Print Specification

• Personal Print Markup Language (PPML)

• PostScript
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Creo Variable Print Specification
Creo Variable Print Specification is the Creo developed formal 
language designed for effective production of VI documents.

Creo Variable Print Specification is comprehensive and can specify 
a complete range of VI documents. It also provides the means for 
efficient implementation - fast and efficient data processing, and 
storage prior to printing.

A Variable Print Specification job consists of the following 
components: 

• Booklet

A personalized copy of a document within a single print run 
where pages and/or elements within a page may vary from 
booklet to booklet.

• Sub-job

All copies of a particular document—for example, book, 
brochure, or flyer—within a single print run. On the IC-301 print 
controller, sub-jobs can be deleted, archived, or reprinted at 
any time. However, you can still maintain reusable elements for 
future runs. Reusable elements are cached elsewhere, so only 
the unique data, which is embedded in the job, is deleted.

• Reusable Elements

Self-contained graphical entities that can be line art, text, raster 
images or a combination of these types. Reusable elements are 
represented in PostScript and can be stored as EPS files when 
appropriate. Reusable elements include clipping and scaling 
instructions as well as the image data.

Note:  Grayscale TIFF and EPS images that are created in CMYK 
applications (such as PhotoShop) are counted correctly as B&W instead 
of Color in both the IC-301 print controller and the bizhub PRO C500 
printer billing meters.
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Reusable elements can be used repeatedly in different pages, 
booklets and jobs. On the IC-301 print controller, all reusable 
elements are processed once and cached as elements for 
further use. They can then be reused either within the sub-job 
itself, or in additional runs of sub-jobs.

• Inline Elements 
Unique information is drawn from a database and is embedded 
in the sub-job. This data prints only once for individual 
booklets.

PPML
The PPML format is a new XML-based industry standard that print-
technology manufacturers developed for the high-speed 
production of reusable page content.

The IC-301 print controller supports PPML formats. Some of the 
features that are included enable you to:

• Process PPML jobs efficiently

• Import jobs in various VI formats to the IC-301 print controller

PPML has a hierarchical structure. Document components are 
separated from their submission file and can be organized and 
stored in different levels of the hierarchical structure.

PostScript Files
PostScript files are suitable for simple, very short run jobs. All page 
elements are re-RIPed for each page. These jobs do not use a VI 
authoring tool at all. Instead, they use a mailmerge function in a 
Microsoft Word document or a Microsoft Excel spreadsheet.
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Using Creo Variable Print Specification to Print a VI 
Job

To print a VI job:

Submit your job to the IC-301 print controller.

Reusable elements are identified and processed and then are 
ready for rapid assembly into pages and for reuse during the 
printing stage.

Your VI job is processed and printed on the IC-301 print controller. 
The bizhub PRO C500 printer prints booklets at full engine speed 
working uninterrupted from the printer disk. Booklets are compiled 
concurrently while the printer prints. As pages are sent to the print 
engine, they are assembled from the various inline and reusable 
elements on-the-fly.

After the job is completed, it is placed in the Storage area. This job 
contains the complete variable job including all booklets, variable 
images, and unique elements.
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Setting Up and Configuring the IC-301 Print 
Controller

Basic system configuration and settings are defined in the IC-301 
print controller Preferences window. The Preferences window 
contains items that enable you to manage your system.

To open the Preferences window:

From the File menu select Preferences.

The Preferences window appears. The settings are divided into 
two lists: Administrator and General. Both lists are explained in 
the following sections.

Administrator items can be viewed by users of all levels, but are 
only available to users of Administrator level. General items can 
be viewed by all user levels, but are only available to users of 
Administrator and Operator user levels. All items in the 
Preferences window are view only to Guest users.
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Server Setup
Set the server’s name and the current date and time in Server Setup.

Changing the Server Name
1. In the Preferences window, select Server Setup.

2. In the Server name area, click Change.

The System Properties dialog box appears.
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3. In the Computer Name tab, click Change.

The Computer Name Changes dialog box appears.

4. In the Computer name box, type a new name for the computer. 

5. If you want to change the Workgroup or the Domain in which 
your computer appears, select the desired option and type a 
new name in the corresponding box.

Note:  Do not change the workgroup or domain unless you are instructed 
to do so.
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6. Click OK.

7. Click OK in the System Properties window.

The system prompts you to reboot your computer for the new 
settings to take effect. 

8. Click No if you want to change other system parameters, or 
click Yes and reboot your computer.

Changing the Date and Time
1. In the Preferences window, select Server Setup.

2. In the Date & Time area, click Change.

The Date/Time Properties dialog box appears.

3. In the Date & Time tab, select your local time settings.

Important:  If you want to change the domain, you will be required to 
type the password for the domain account. If the password is 
unavailable, the computer will be locked.
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4. Select the Time Zone tab and set the correct time zone.

5. Click OK.

Network Setup
The IPX printing settings, TCP/IP settings and the Apple Talk setup 
settings are specified in the Network Setup parameter.
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IPX Printing
IPX printing enables the IC-301 print controller to act as a job 
server for the Novell queue. A job server checks each assigned 
queue at a specified interval, taking care of jobs on a first-in, first-
out basis. Once a job is processed, its associated file is deleted 
from the queue directory.

To set the IC-301 print controller IPX parameter:

1. In the Preferences window, select Network Setup.

2. In the IPX printing area, click Change next to the Tree parameter.

The Local Area Connection Properties dialog box appears, 
followed by the NWLink IPX/SPX Properties dialog box.

3. To change the frame type, select a frame type from the Frame 

type list, then click OK.

4. Click OK also in the Local Area Connection Properties window.

You are prompted to restart your computer. 

5. Click No if you need to make more changes, or Yes to reboot.

Note:  Using this procedure requires further setup by the network 
administrator.
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TCP/IP Setup
The IC-301 print controller is predefined with a default IP address. 
The TCP/IP option enables you to change this IP address and 
other TCP/IP settings.

To change the TCP/IP network settings:

1. In the Preferences window, select Network Setup.

2. In the TCP/IP area, click Change Settings next to the IP Address 

parameter.

The Local Area Connection Properties dialog box appears, 
followed by the Internet Protocol (TCP/IP) dialog box.

3. Select one of the following options:

• Obtain an IP address automatically: To change the IP Address

• Use the following IP address: Type the desired address—for 
example, IP address:192.168.62.1 and Subnet 

mask:255.255.255.0.

4. Click OK.

Note:  Before changing the network settings, consult your System 
Administrator.
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5. Click OK in the Local Area Connection Properties window.

You are prompted to restart your computer. 

6. Click No if you need to make more changes, or Yes to reboot.

Apple Talk Setup
The AppleTalk Setup utility enables you to change the AppleTalk 
zone in which your IC-301 print controller is located.

To change the Apple Talk network settings:

1. In the Preferences window, select Network Setup.

2. In the Apple Talk Setup area, click Change next to the The System 

will appear in zone parameter.

The Local Area Connection Properties dialog box appears, 
followed by the AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your 
computer, and click OK.
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Remote Tools Setup
The Remote Tools Setup enables you to connect from a client 
workstation to the IC-301 print controller over the network using 
the Web Center . 

To enable web connections:

1. In the Preferences window, select Remote Tools Setup.

2. In the Web connect setup area, select Enable Web Viewer.

For more information about viewing and monitoring your jobs from a client 
workstation, see Web Center on page 32.
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Security

User Passwords and Access Levels
The Auto Log on check box is selected by default so that you don’t 
have to log on to the IC-301 print controller each time. If you want 
each user to have to log on to the IC-301 print controller, you need 
to set the security settings. You can assign each user an access 
level and password. There are three access levels:

• Operator (default): Enables the user to operate the IC-301 print 
controller and configure the General area in the Preferences 
window

• Administrator: Enables the user to access all features and 
settings in the IC-301 print controller

• Guest: Enables the user to import a job through an existing 
virtual printer and view the workspace

To set Password settings:

1. In the Preferences window, select Security.

2. If you want each user to have to log on to the IC-301 print 
controller, clear the Auto Log On check box. 
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3. In the Administrator area, perform the following steps:

a. If you are changing an existing password, type the 
password in the Enter old password box.

b. In the Enter new password box, type a new password.

c. In the Verify new password box, type the new password 
again.

d. Click Apply.

4. If you want to set a password for operators, repeat steps 3a-d 
in the Operator area.

5. If you don’t want guest users to access the IC-301 print 
controller, select the Disable guest connection check box.

6. Click Save.

Logging On as a Different User
If you are already working in the IC-301 print controller workspace, 
you can change your access level—for example, if you are logged 
on as an operator and you need administrator priveleges.

1. From the File menu, select Log On As Different User.

2. In the Access Level list, select a different access level.

3. If you want to log on as an administrator or operator, type your 
password.

Note:  This option is not available if you selected the Auto Log On 
option.

Note:  If you want to log on as a guest, you don’t need a password.
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4. Click Logon.

You are logged on with the new access level.

Disk Wipe
Usually when you delete a file, the file’s dictionary entry is removed 
but data still remains on the disk. The Disk Wipe utility enables you 
to clear previously deleted files. The utility eliminates the contents 
of your deleted files by scanning all of the empty sectors on the 
disk and replacing them with zeros. Non empty sectors are left 
untouched. This feature enables you to work in a more secure 
environment. If there is a system shutdown, the disk wipe 
operation can begin immediately.

To operate the IC-301 Disk Wipe utility:

1. In the Preferences window, select Security.

2. Select the Wipe disk on system shutdown check box.

3. Click Save.

4. Exit the IC-301 print controller software.

After a few minutes, the following window appears.

5. Click Start Wiping.

A progress bar appears while the disk wipe operation 
permanently deletes files.
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6. When the message Disk wiping was completed 
successfully appears, click Exit.

System Disks
When the Printer disk or User disk reaches a pre-defined threshold 
of minimum available space (the default is 250 MB), RIP is 
suspended and the system provides a warning message. The RIP 
will resume automatically only after disk space is available. 

Notes:

• The disk wipe operation does not function well when the Norton Utilities 
application is installed. Before you activate the Disk Wipe utility, make 
sure that Norton Utilities is not installed on the IC-301 print controller.

• In rare cases, the process of deleting files from the Storage area is not 
completed—for example, the system shuts down before the deletion 
process is completed. In these cases, parts of the deleted files still reside 
in the D:\Output folder. Therefore, it is recommended that before you 
start the disk wipe operation, check the D:\Output folder to ensure that 
all the relevant files were deleted.

• The Disk Wipe utility affects the user disk and Printer disk.

• Do not operate the Disk Wipe utility while another application is running.

• The supported language is English.
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To set the system disks threshold:

1. In the Preferences window, select System Disks.

2. In the System Disks area, set the minimum free disk space 
desired for RIP.

Scan Management
The scanbox access control and scan jobs settings are set in the 
Scan Management settings.

For more information about using scan boxes, see Setting Up Scan Boxes on 
page 47.
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Setting the Scanbox Access Control
1. In the Preferences window, select Scan Management.

2. Set the ScanBox Manager access control for the administrator 
only or for all users. This option specifies who can set up and 
manage scan boxes.

Setting the Delete Scan Jobs
1. In the Preferences window, select Scan Management.

2. In the Delete scan jobs after box, set the desired number of days 
after which the system automaticallly deletes scanned jobs 
saved to the Public scan box. By default, the system deletes 
all of the scanned jobs in the Public scan box on a daily basis.

3. Click the Delete Now button to delete scanned jobs from the 
Public scan box.. 
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Localization
The Localization measurements and the Language are set in the 
Localization area.

Setting the Localization Measurement
1. In the Preferences window, select Localization.

2. In the Units area, select Millimeters or Inches, as desired.

Setting the Language
1. In the Preferences window, select Localization.

2. In the Language area, select the language, as desired.

Note:  If you switch to another language, you need to restart the IC-301 print 
controller software.
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Deletion Policy

When jobs have been handled by the IC-301 print controller, they 
are stored in the the Storage area. You can specify a number of 
days after which the jobs are removed from the Storage area.

To delete jobs from the Storage area:

Select the Automatically delete jobs from Storage check box, and 
enter the desired number of days.
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Pre-RIP Preview

Setting the PS Preview Preferences
1. In the Preferences window, select Pre-RIP Preview.

2. In the PS Preview area, specify the desired action when you 
close the Adobe Acrobat preview window, save the file as a 
PDF, or return to the original PS file.

Setting the VI Jobs Preview
In the VI jobs preview area, select the desired number of 
booklets you want to preview before the job is processed.
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Print Queue Manager

Setting the Job Batching Policy
1. In the Preferences window, select General Defaults.

2. In the Job batching policy area, enable or disable the job 
batching option.

Held Jobs Policy
In the Held jobs policy area, select one of the following options:

Bypass held jobs: To bypass held jobs in the Print Queue

Don’t bypass held jobs: To stop printing from the Print Queue 

when a job is assigned a held status
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Default Image Size

1. In the Preferences window, select Default Image Size.

2. Select the default size in which to view images in a job.
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Calibration Device

1. In the Preferences window, select Calibration Device.

2. In the Calibration Device area, select one of the following 
options:

• Calibration is done off-the-glass: Uses the scanner platen to 
measure the calibration charts

• Calibration is done using a DTP34: Uses the DTP34 
densitometer to measure the calibration charts

System Messages
While jobs are being handled by the IC-301 print controller, various 
messages are emitted. Messages about each job are stored in the 
Job Log and messages generated during a session are stored in 
the Messages window.

For more information about how to perform calibration, see Calibration Process 
on page 105.



System Messages 149

System Disks Threshold Message
When the Printer disk or User disk reach a pre-defined minimum 
available space threshold (usually of 250 MB), RIP is suspended 
and the system provides a warning message. The RIP resumes 
automatically only after disk space is available. In this case, you 
may increase the system disk threshold.

Job History
The Job History window lists all of the messages that were 
generated during the workflow of the selected job. You can view 
the job title and owner (the user name of the system from which the 
job originated).

To open the Job History window:

Right-click a job in the Storage area, and from the menu select 
Job History.

For more information about setting the system disks threshold, see System 
Disks on page 140.
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Message Information
For each message, the following information is indicated by 
default:

• An icon denoting the type of message (Error, Warning, or 
Information)

• Date and time on which the message was emitted (the time 
stamp)

• Stage in the workflow—for example, Print Queue or Process 
Queue

• Message text

You may filter the messages by type, and/or sort the list by one of 
the column headers. 

Messages 

To open the Message Viewer window:

From the Info menu, select Messages.

The Message Viewer window appears and lists all of the 
messages that were generated during the workflow. 

For more information about viewing messages related to a specific job, 
see Job History on page 149.
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By default, all the jobs that were handled during the last 3 
months (90 days) are listed. 

Managing Messages
You can filter the messages by type, and/or sort the list by one of 
the column headers. In addition, you may print the list of 
messages.

If desired, you may reorder and resize columns, filter the list or sort 
the list by one of its column headers.

Notes:

• This section is relevant for the Message Viewer window and the Job 
History window.

• These settings are retained after closing a window.
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Filtering the Messages by Type

Each message in the Message Viewer window and Job Viewer 
window is assigned an icon to denote the message type:

You can filter the list in order to view only messages of certain 
types. By default, all message types are listed in the Message 
Viewer window. 

Click any message type icon—for example, Error— in order not 
to list such messages.

The list updates accordingly.

Printing the Message List

You can print the information as it is presented in the Message 
Viewer window (as it is currently filtered and sorted).

To print the message list:

1. Filter and sort the list as desired (the data is printed according 
to the current filtering and sorting).

2. Click Print List.

The Print window is displayed.

3. Set the printing options as desired, and then click OK.

Information

Warning

Error

Note:  If the message type is not selected, messages of this type do not 
appear in the list.
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Backing Up and Restoring the Configuration
The Backup & Restore Configuration feature enables you to backup 
your IC-301 print controller configuration to a local hard disk, 
network drive, or to an external media—for example, an external 
zip drive—connected to the IC-301 print controller.

To backup the configuration of your IC-301 print controller:

1. On the toolbar, click Resource Center. 

The Resource Center window appears.

2. In the Resource box, select Backup & Restore Configuration.

3. In the Backup configuration area, click Browse. 

The Save dialog box appears.

4. Find the desired directory path for the backup.

5. Enter the required file name.

6. Click Save.

Note:  You can also backup to an external media.

Note:  It is recommended that you use the current date as part of the file 
name.
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7. In the Resource Center window, click Start Backup.

After a few minutes, the backup completed message appears.

To restore the configuration of your IC-301 print controller:

1. On the toolbar, click Resource Center. 

The Resource Center window appears.

2. In the Resource box, select Backup & Restore Configuration.

3. In the Restore Configuration area, click Browse. 

The Open dialog box appears.

4. Locate the directory path in which you backed up the 
configuration.

5. Select the file, and then click Open.

6. Click Start Restore.

The Restore configuration window appears.

7. Select the categories you want to restore, and click OK.

Note:  The last path will be saved and displayed to the path box. If the 
backup was made to an external media, the displayed path will be the 
default: C:\IC-301\General\Configuration.

Notes: 

• You may also restore the configuration from an external media.

• The configuration file extension will always be .cnf.

Note:  When you restore the configuration, all the custom tables and 
sets—for example, new virtual printers—are added to the system.
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Setting Parameters in the Job Parameters Window
This appendix describes each parameter in the job parameters 
window.

Print 
The Print parameters enable you to set print-related job parameters 
such as the print range, the number of copies you would like to 
print, the print method and order. 

The IC-301 print controller uses multiple paper stock parameters 
such as Paper size, Media type, and Tray to specify the media type. 

If the selected media type is unavailable, the current job is held 
until the appropriate set is available (the job receives an on hold 

status indicator, and a message appears in the Message Viewer 
window). Other jobs can print while jobs are held.
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Copies and Pages

Copies

Enter the number of copies to be printed.

Pages

Select a page range. 

If the printed job is a VI job, the Pages option changes to Booklets. 
To select specific pages, booklets, or page ranges, specify the 
pages or booklets to be printed as follows:

• Type one or several numbers separated by commas and no 
spaces—for example, 1,3,5.

• Type a range of pages or booklets with a hyphen between the 
starting and ending numbers in the range—for example, 1-5.

Print Method
Select one of the following options:

• Simplex: for single-sided printing

• Duplex head to head: for printing book-style hard copies 
(usually used with portrait jobs)

• Duplex head to toe: for calendar-style hard copies (usually 
used with landscape jobs))

Paper Stock

Paper Size

Select the desired paper size. If you select Custom, type the 
required width in the W box and the required height in th H box.

Note:  For imposed jobs, instead of typing the desired pages, type the 
desired imposed sheets.

Note:  Units of measurement (mm or inches) reflect system configuration. 
You choose units in the Preferences window (see Localization on 
page 143).
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Wide paper

This check box supports the wide paper option in the bizhub PRO 
C500 printer.

Media type

Select the desired media type. The default setting is Use Printer 

defaults. When this option is selected, your job is printed on the 
media type that is defined on the bizhub PRO C500 printer.

Gloss Mode

Select this check box to give a glossy look to your printed 
output.

Weight

Select the desired media weight. The default setting is Use 

Printer defaults. When this option is selected, your job is printed 
on the paper weight that is defined on the bizhub PRO C500 
printer.

Tray
Select the desired tray:

• Tray 1, Tray 2, Tray 3, Bypass, LCT: Load the specified stock in 
this tray.

• Force Tray: Centers and prints the job on the paper size that 
is in the selected tray. The Paper Stock options are ignored.

• Auto: The bizhub PRO C500 printer will use any tray with 
the specified stock. 

Note:  If you select the Force Tray check box for a job that uses 
imposition, the paper size that is in the selected tray is printed on the 
imposed sheet.

Note:  The Auto tray option uses the paper in the selected tray only 
if it complies with all the other paper stock parameters. If the paper 
stock in the assigned tray doesn’t match all of the job’s parameters, 
the job is held.
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Imposition
The Imposition parameters enable you to select job options related 
to the positioning, folding, trimming, and binding of pages.

Imposition Method
The Imposition Method parameter specifies how printed sheets are 
finished. You to choose a method according to the finished format 
that you need.

Select one of the following options:

• None: This is the default option. If you select None, the 
imposition parameters are unavailable and the thumbnail 
viewer does not display an image.

• Step & repeat: Use this option for printing multiple copies of 
the same image so it fills up a larger sheet. This method is 
used mainly for printing business cards.

• Cut & stack: Use this option to enable step & repeat jobs to 
be printed, cut, stacked and bound in the most efficient 
manner, while preserving the original sorting. A job’s pages, 
booklets, or books are sorted in a Z-shape. In other words, 
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each stack of pages is sorted in consecutive order. When 
stacks are piled one on top of another, the entire job is 
already sorted up or down.

• Saddle stitch: Use this option for a book-finishing technique 
where the pages of a book are attached through stitching or 
stapling in the spine fold —for example, brochures.

• Perfect bound: Use this option for a book-finishing technique 
where the pages of a book are attached through trimming 
of the spine fold, roughening the edges of the gathered 
pages and gluing them together—for example, hardcover 
books.

Size

Sheet size

Select the required sheet size. If you select Custom, type the 
required width in the W box, and the required height in the H 
box.

Wide paper

This check box supports the wide paper option in the bizhub PRO 
C500 printer.

Trim size

In the Trim size list, select the desired trim size. If you select 
Custom, type the required width in the W box, and the required 
height in the H box.

Trim orientation

Select the desired orientation, Portrait or Landscape for the trim 
size.

Trim size is the size of the finished, trimmed document.
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You can adjust your page size by adjusting the trim size.

Trim orientation specifies the orientation, portrait or landscape, for 
the trim size. If the wrong orientation is specified, an unsuitable 
template might be selected and the job might be cropped as a 
result.

Templates

Category

1. In the Columns list, select the number of pages to place 
horizontally. The rows and columns indicate how the pages will 
be placed on the sheet.

2. In the Rows list, select the number of pages to place vertically. 

Print method

Select the desired layout—for example, Duplex HTH or Duplex 

HTT. 

North south

Select this check box if the template you chose is either step 
and repeat 2×1 or 1×2. The pages will be placed 180 degrees 
from each other, on the same side of the imposed sheet. 

Note:  If you set the trim size to be smaller than the page size set in the DTP 
application, some of the data is cropped. Setting a larger trim size results in a 
larger border on the printed page.
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Right Binding

This check box is only available if the imposition method is either 
saddle stitch or perfect bound, and the template is 2×1, 2×2, or 
4×2.

Spacing

Marks

In the Marks list, select one of the following options:

• Crop marks: To print the lines that indicate where the sheet 
should be cropped. To print the crop marks on both sides of 
the page, select the Both Sides check box.

• Fold marks: To print the lines that indicate where the sheet 
should be folded. 

Bleed size

Enter a value. The value that you enter depends on the paper 
size and imposition method you choose.

When you set bleed options, you extend part or all of the printed 
image beyond the trimming boundary. The bleed options ensure 
that an inaccurate trim setting will not leave an undesired white 
space at the edge of the page. The bleed options produce sharp 
page boundaries with color that extends all the way to the edge of 
the page.

Notes:

• If you want to use crop marks incorporated in the DTP 
application, make sure that enough space is left around your 
page in the PostScript file so that the page prints with crop 
marks.

• If your job already includes crop marks incorporated in the DTP 
application, you do not need to add crop marks here. If you do 
add crop marks, both sets of crop marks can be printed.

Notes: 

• You cannot extend the bleed size beyond the sheet fold lines. Bleed does 
not affect the position of crop.

• Bleeding must be defined in your DTP application in order for the IC-301 
print controller to be able to apply the bleed options.
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Margins

Enter a value to adjust the spaces between the outside edges 
of pages and the edges of the sheet on which they are printed. 

Gutter

Enter a value. The value that you enter depends on the paper 
size and imposition method you choose.

The gutter size is the space between pairs of pages (according to 
the trim size) on a sheet. When the pages are folded into a booklet, 
the gutter allows space for trimming.

Spine size

Enter a value. The value that you enter depends on the paper 
size and imposition method you choose.

Creep
Creep is a common problem in saddle-stitch jobs. When 
signatures are inserted inside one another, the signatures inserted 
last are the farthest from the center of the booklet. As a result, the 
outer edges of the inner pages creep past the outer pages.

Creep in

Select one of the following options:

Auto: To automatically set a value based on media weight

Custom:To enter a custom value

Creep out

Enter a value.The value that you enter depends on the paper 
size and imposition method you choose.

Notes:

• Margin settings should suit finishing equipment and requirements.

• Confirm binding parameters with your binder when planning your 
sheet.

Note:  It is recommended that you use a border around all documents when 
you use creep.
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Quality 
The Quality parameters enable you to set print quality related job 
parameters and to improve the quality of printed jobs. These 
parameters include the possibility to enhance text and graphics 
quality, set trapping, and to define the black overprint.

Image/Graphics Quality

Graphics quality (Text, Line)

Select High to improve the text quality in a job. 

Graphics quality (Text, Line) refers to the Creo anti-aliasing algorithm 
for text quality. This option causes blends to appear smooth with 
no banding, and displays crisp diagonal lines without (or with 
minimal) jaggies (rough edges) that are the result of the limited 
resolution of the print engine.

Note:  It is recommended that you use this option only if your source file 
includes diagonal lines or text with jaggies.
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Image quality

Select High to improve the quality of images in a job.

Image quality refers to the ability to maintain the same detail and 
smoothness with different degrees of enlargement. This feature is 
especially useful when your PostScript file includes several images 
at different qualities—for example, images that were scanned at 
different resolutions, were rotated, or downloaded from the 
internet.

Trapping
1. Select the Enable Trapping check box to apply trapping.

2. In the Frame thickness box, enter the desired value for the 
thickness of the trapping frame. 

Protect small text

Select this check box so that any text that is smaller or equal to 
12 pt. is not framed during FAF.

Trapping is a solution that solves misregistration between color 
separations in both offset and digital printing. This occurs no 
matter the accuracy of the printing device, and results in white 
lines around objects on top of a background (in a knock-out 
procedure) and also between adjacent colors.

Protect small text is an option you may apply for small or complex 
images, since thicker frames can decrease quality by hiding parts 
of an image. Selecting this option will protect any text smaller or 
equal to 12 pt by not framing it while applying the FAF algorithm.

Frame thickness refers to the thickness of trapping. The thicker the 
frame, the less chance that white areas appear between images.

Note:  If you don’t select the Enable Trapping check box, it does not 
affect trapping incorporated by DTP applications—for example, 
Photoshop. FAF should not be used with application based trapping. In a 
PostScript file that already contains trapping from the originating 
application, it is not necessary to use IC-301 print controller trapping.
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Overprint

Black overprint

Select this check box to ensure that black text prints cleanly 
within a tint or picture area.

The text appears in a richer, deeper black, with the underlying CMY 
values equal to those of the printed background.

PS overprint

Select this check box to use the overprint information that 
exists in the PostScript file. 

This parameter also determines whether the DTP application 
PostScript overprint settings are honored in the RIP.

Screening
Select the required option. For CT images, use a dot option, 
and for LW images, use a line option. 

Screening converts CT (Continuous Tone) and LW (Line Work) 
images into information (halftone dots) that can be printed. The 
human eye “smooths out” this information, which seems visually 
consistent with the original picture. Thus, the more lines per inch, 
the more natural the image appears. 

Screening is achieved by printing dots in numerous shapes or 
lines in an evenly spaced pattern. The distance between the 
screen dots or lines is fixed and determines the quality of the 
image.

Printers can work with even amounts of toner and still produce a 
wide range of colors when you use screening. The darker the 
color, the larger the dot. 

Color 
The Color parameters provide you with tone compression tools 
such as brightness, contrast and gradation. You can also select 
rendering intent, source profiles for RGB and CMYK, and 
destination profiles. 
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The tone compression tools, Gradation, Brightness, and Contrast 

can be applied to your processed jobs without requiring the IC-301 
print controller to re-RIP the jobs. The color tools, Destination 

Profile, Rendering Intent, Emulate Paper Tint, and Spots, should be 
applied prior to initial RIPing or your job will need to be re-RIPed.

Color Mode
Select one of the following options: 

• Grayscale: To print the job as black and white using Black 
(K) toner only. When a color job is printed using the 
Grayscale option, the Cyan (C), Magenta (M), and Yellow (Y) 
separations are also printed in Black (K) toner, giving a 
dense appearance similar to the CMYK grayscale image.

• Color: To print the job in color using CMYK.

Note:  Grayscale images created in RGB applications, such as 
PowerPoint, should be specified as Monochrome or submitted to the 
system with Grayscale selected in the PPD file. This selection 
ensures that grayscale images are counted as black and white 
instead of color in both the IC-301 print controller and in the bizhub 
PRO C500 printer billing meters.
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Color Adjustments

Brightness

Select the required brightness level (the range starts from 
Lightest, which applies -15%, to Darkest, which applies +15%).

Brightness is generally used to make last-minute adjustments to 
the print job after proofing. By changing the Brightness setting, you 
can control how light or dark your output will appear. 

Contrast

Select a contrast level for the print job, (the range starts from 
Less which applies -10%, to More which applies +10%).

Adjusting the Contrast enables you to control the difference 
between the light tones and the dark tones in your image.

Contrast is generally used to make last-minute adjustments to the 
print job after proofing.

Saturation

Select one of the following options:

• Normal: To maintain the gray balance throughout the range 
of colors in the print job file

• High: When you need dark colors that are more intense.

Gradation

Select one of the following options:

• None: The printer applies maximum dry ink coverage. This is 
the default setting.

• Cool: Blue tones appear clearer

• Lively: Increases the color saturation

• Sharp: Increases the contrast

• Warm: Sets the hues in the low densities to a bright reddish 
color
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The Gradation parameter contains a list of gradation tables that 
were created in the IC-301 print controller Gradation Tool window. 
Each gradation table contains specific settings for brightness, 
contrast, and color balance.

When you select your predefined gradation table, your job is 
adjusted according to the specific table’s settings.

Ink Saving

GCR

Select Yes to conserve toner by replacing the gray component 
(CMY) of pixels with black toner.

The gray component replacement also prevents the consequences 
of excessive toner buildup, such as flaking and cracking, or the 
"curling" effect that may occur when printing transparencies.

While the gray component of each color is replaced by black, there 
is no change in the color quality of the printed image.

Identify black

Select this check box if you want RGB gray text and graphics 
to be printed with black toner only.

The Identify black check box not only affects R=G=B values, but 
may also cause slightly different values 
(R+/-4=G+/-4=B+/-4) to produce gray.

Color Flow

CMYK source profile

Select the desired CMYK source profile. If you select an 
emulation profile the following options are available:

• Emulate source paper tint: To emulate the original paper tint if 
it is included in the profilel

Notes:

• If the job is simplex, only the front side will be printed using the 
tint emulation.

• When the Emulate paper tint check box is selected, Absolute 

Colorimetric will be used as the rendering method.
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• Preserve pure colors: Preserves pure cyan, magenta, yellow, 
and black during transformation

• Emulate RGB Elements: Converts RGB elements according 
to the selected CMYK emulation method. The RGB 
elements receive the same look as the CMYK elements, 
creating a consistent appearance. 

CMYK rendering intent

Select the desired CMYK rendering intent.

RGB source profile

Select the desired RGB source profile.

RGB rendering intent

Select the desired RGB rendering intent.

Spot handling

Select one of the following options:

• Print as spot: To use the spot color dictionary

• Print as process: To ignore the spot color dictionary

Destination profile

Select the required profile. You can select a custom or the 
predefined destination profile, CPP500.

When you import a custom destination profile via the Profile 
Manager, it will then be displayed in the Destination Profile list. 

Finishing 
The Finishing parmeters enable you to select various options to 
finalize your printed documents. 

For more information about rendering intent, see Rendering Intent on 
page 194.

For more information about the spot color dictionary, see Editing and 
Creating Spot Colors on page 111.
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Finisher Module

Tray

Select one of the following exit trays for your printed output:

• Paper Exit tray: Use this option if a finisher is not connected.

• Sub tray: Prints to the finisher’s upper tray

• Main tray: Prints to the finisher’s stack tray

• The Offset check box is selected by default. If you don’t 
want to use an offset between sets, clear this check 
box.

• The Staples list enables you to specify where you want 
to position the staples on the page.

• The Punch check box is active only if a punch kit is 
available. There are three punch units available, 2 hole, 
3 hole , or 4 hole.

• Booklet tray: Prints to the booklet finisher

• In the Tray list, select the fold type. Center Fold folds your 
booklets in the center of the page. 3-Fold folds your 
booklets in an accordion fold.

• Select the Staples check box if you want center staples.

• The Trim check box is active only when a trimmer unit is 
available.

Print Order

Collated

Select this check box to print a complete copy of the job before 
the first page of the next copy is printed.

Reverse print order

Select this check box to set the print order from back to front.

Note:  If you want to staple or punch the other side of your job, select the 
Rotate 180 check box on the Print Method parameter.
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Face up

Select this check box to deliver a job face up.

Face down

Select this check box to deliver a job face down.

Slip Sheets

Slip sheets between copies

1. Select this check box to print slip sheets with your job.

If you want to collate the job, the slip sheets are printed 
between sets. If you want the job uncollated, the slip sheets are 
printed between groups.

2. In the Tray list, select the tray in which the specified media type 
is loaded.

Layout

Rotate 180

Select this check box to rotate your job by 180°.

Scaling

Select one of the following options:

• Manual: Enter the percent by which you want to 
proportionally decrease or increase the image size.

• Fit to ouput sheet size: For the image to fit the selected paper 
sheet size. 

Note:  When you collate a document, select Face down (Face up) and 
From N to 1 (From 1 to N) in the Print order parameter to print the set 
in the correct order.

Note:  You can also use the Fit to output sheet size option to scale 
the layout for imposed jobs.
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Image Position
The Image Position feature enables you to change the location of 
the entire printed image on the sheet (simplex or duplex).

This function uses the following terminology: 

• Rear: the sheet's edge near the printer rear, where printing 
stops

• Lead: the edge of a sheet at which printing begins

The page’s lead and rear edges are determined just after the page 
is printed out, before making any change in the page orientation. 

Select one of the following options:

To print your job in the center of the page, click Center.

To set page offsets, enter Rear and Lead values.

To apply page offset values to both odd and even pages, select 
the Same on both sides check box. 

Exceptions
Exceptions are used when you want to use different media types 
for special exceptions within a job or add inserts (interleaves).

Note:  Use this option to move duplex page data away from the spine. 
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1. In the Type list, select the pages in your job in which the media 
type will be different.  

2. Depending on the option you selected in the Type list, perform 
one of the following steps:

a. For Page range, type the page range in the box.

b. For Front cover or Back cover, select Duplex to print the first 
two (or last two) pages of the job as the cover page (back 
cover).

c. For Inserts, select Before or After and type the page number 
that will precede or follow the insert. Then, in the Quantity 
box, type the total number of inserts you want to add.

3. In the Tray list, select the tray in which the specified media type 
is loaded. 

4. Click Apply.

Note:  If the imposition type is saddle stitch, select Cover to print 
both a front and back cover page on a different media type. Select 
Middle sheet to print the internal sheets on a different media type.
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Services 
The Services parameters enable you to set job parameters that will 
assist your job workflow.

Admin Page
1. Select the Admin Page check box.

2. In the Use Tray list, select the tray in which the media type you 
want to use is loaded.

The administration page contains job-related information such as 
the job title, page size, number of pages or sets, and the sender 
name. 

The administration page is printed in the same order as the job, for 
face-down printing the page is printed before each set and for 
face-up printing the page is printed after each set.

Note:  If you change the options in the Admin page parameter, the job needs 
to be re-RIPed.
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APR/OPI
In the APR/OPI area, select one of the following options:

• High resolution images: To replace low-resolution images in your 
job with high-resolution images that are located in a specified 
APR or OPI path.

• Low resolution images: To print the job with the existing low-
resolution images—for example, for proofing purposes.

There are two default paths in which the IC-301 print controller 
searches for high-resolution images:

• Search in the input folder: The IC-301 print controller first 
searches for high-resolution images in the same folder as the 
PDL file. 

• D:\Shared\High Res: If you want to save your high-resolution files 
in this folder, copy the files to D:\Shared\High Res. 

You can also add a new high-resolution path, and then edit, or 
delete the path.

Paths other than the default paths are defined on a per-job basis, 
or set in the virtual printer. You can specify paths on local hard 
drives, CD-ROM drives, and the floppy drive connected to the IC-
301 print controller. You can also specify paths on remote clients or 
file servers.

To add a high-resolution path:

1. Under the APR path box, click Add.

The HiResPath dialog box appears.

2. Click Add.

The Select dialog box appears.

3. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

4. To promote or demote a selected APR path, use the arrow 
buttons.

Note:  The order in which the APR paths are listed is the order in which 
the IC-301 print controller searches for the high-resolution images.
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To delete a high-resolution path:

1. In the HiResPath dialog box, select the path you want to delete.

2. Click Remove.

The selected path is deleted.

Job Deletion
Select this parameter when you are printing a large VI job that 
takes up a substantial amount of the IC-301 print controller disk 
space. When you select this parameter, the IC-301 print controller 
deletes each page on the fly once it has been successfully printed. 
In this way, the IC-301 print controller maintains enough free disk 
space for the duration of the print run. Reusable elements are not 
deleted.

Select one of the following options:

Delete printed jobs: To remove pages or jobs from the IC-301 
print controller after printing is completed

Delete failed jobs: To remove failed jobs while processing or 
printing from the IC-301 print controller

Font Substitution
Select this check box to substitute a missing font with the 
default font that is set in the Resource Center.

PDF Optimization
Select the PDF optimization check box if you have a PDF job with 
repeated elements and want to significantly decrease processing 
time by applying the PDF workflow. The PDF workflow caches the 

Notes:

• The Delete failed jobs option sustains enough free disk 
space for the duration of the print run and only affects 
the sub-job.

• The Variable Print Specification file is also deleted.

Notes:

• If a font is substituted, a message appears in the Job History window.

• You can only substitute Latin fonts.
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repeated elements in the PDF once, and reuses them as much as 
required without repeated processing. 

To ensure that repeated elements are marked as repeated in the 
PDF file, distill the PostScript file using the Adobe Acrobat Distiller 
software.

Job Info
This parameter provides the following information:

• Job title: Original name of the file related to this job

• Sender: User name of the system from which this job originated

• Account: Account number of a specific customer or group

• Recipient: Name of customer

• Job comments: Any special instructions that you want to include 
with your job

Important:  Verify that in your Acrobat Distiller settings, Optimize for Fast 

Web View is selected (in Acrobat 4.0 the corresponding option is Optimize 

PDF).
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Setting Parameters in the PPD File
You can set job parameters from a client workstation using the IC-
301 print controller PPD file, or you can define a virtual printer with 
predefined PPD file settings. Table 12 lists all of the PPD 
parameters available.  

Notes:

• In the PPD file, the Printer’s Default option is selected for all PPD file 
parameters. The Printer’s Default option corresponds to the settings of 
the currently selected virtual printer.

• The parameter settings that were last modified or applied are the settings 
that are applied to the job. However, the print settings defined in the job 
file override the settings of the virtual printer.

• Grayscale images created in RGB applications (such as PowerPoint) 
should be specified as monochrome or you should select Identify Black 

in the PPD file when you submit the job to the IC-301 print controller. This 
selection ensures that grayscale images are counted as black and white 
instead of color in both the IC-301 print controller and in the bizhub PRO 
C500 printer billing meters.
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Table 12: ‘‘List of PPD file parameters

PPD Parameter Printing Options

Duplex See Print Method on page 157

Paper Size See Paper Size on page 157

Media Type See Media type on page 158

Gloss Mode See Gloss Mode on page 158

Media Weight See Weight on page 158

Tray See Tray on page 158

Force Tray See Tray on page 158

Color Mode See Color Mode on page 167

Brightness See Brightness on page 168

Contrast See Contrast on page 168

Saturation See Saturation on page 168

Spots See Spot handling on page 170

Gradations See Gradation on page 168

GCR See GCR on page 169

Identify Black See Identify black on page 169

CMYK Source Profiles See CMYK source profile on page 169

Emulate Paper Tint See CMYK source profile on page 169

Preserve Pure Colors See CMYK source profile on page 169

Emulate RGB Elements See CMYK source profile on page 169

Rendering Intent for 
CMYK

See CMYK rendering intent on page 170

RGB Source Profiles See RGB source profile on page 170
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Rendering Intent for 
RGB

See RGB rendering intent on page 170

Destination Profile See Destination profile on page 170

High Text and Graphic 
Quality

See Graphics quality (Text, Line) on page 164

High Image Quality See Image quality on page 165

Trapping See Trapping on page 165

Black Overprint See Black overprint on page 166

PS Overprint See PS overprint on page 166

Screening See Screening on page 166

Exit tray See Finisher Module on page 172

Staples See Finisher Module on page 172

Punch See Finisher Module on page 172

Fold See Finisher Module on page 172

Trim See Finisher Module on page 172

Offset See Finisher Module on page 172

Face up See Face up on page 173

Reverse print order See Reverse print order on page 172

Slip Sheets See Slip Sheets on page 173

Collation See Collated on page 172

Rotate 180 See Rotate 180 on page 173

Image Scale See Scaling on page 173 

Front Cover (Simplex) See Exceptions on page 174

Table 12: ‘‘List of PPD file parameters

PPD Parameter Printing Options
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Front Cover (Duplex) See Exceptions on page 174

Back Cover (Simplex) See Exceptions on page 174

Back Cover (Duplex) See Exceptions on page 174

Admin Page See Admin Page on page 176

APR See APR/OPI on page 177

Automatic Deletion See Job Deletion on page 178

Image Orientation See Image Position on page 174

 Job Info (PC Only) See Job Info on page 179

Table 12: ‘‘List of PPD file parameters

PPD Parameter Printing Options
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24 bit/3 byte image An image can be either RGB or CMY and each of the three 
colors uses 1 byte or 8 bits of data. Since 3 bytes equals 24 
bits, these images are also known as 24 bit images. This 
system is used for high quality video imaging and scanning. 
For process color printing, a fourth color (black) is added for 
optimum effect. 

32 bit/4 byte image An image that uses 8 bits each for CMYK pixels, or 8 bits for 
each RGB pixel and 8 pixels for a mask layer or other future 
use. Since 4 byte equal 32 bits, these images are also known 
as 32 bit images. An 8 bit CMYK image is the minimum 
required for high quality print reproduction. 

4 color printing Color reproduction method used to create full color output by 
overlaying cyan, magenta, yellow and black inks.

8 bit/1 byte image An image limited to 256 tones of one color or 256 different 
colors. Since 1 byte contains 8 bits and each bit has two 
choices, 1 byte equals 28 choices or 256 possibilities.

Additive color model Color system in which the picture is composed of the 
combination of Red (R), Green (G) and Blue (B) light 
transmitted by the original subject. Effective for monitors and 
TV's but not for print. Scanners normally first scan in RGB and 
it is converted into CMYK for printing. See also RGB, CMYK, 
Process colors, Subtractive color model.

Absolute Colorimetric A rendering intent method similar to Relative Colorimetric 
except that it does not make adjustments according to the 
white point. In this method, colors that do not fit within the 
output color space are rendered at the extremes of the output 
color space. Colors that fall inside the output color space are 
matched very accurately. 
This method is valuable for representing “signature colors“. 
Colors that are highly identified with a commercial product 
such as the cyan in the Creo logo.

Glossary
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Amplitude Modulation Halftone screening, as opposed to FM screening, has dots of 
variable size with equal spacing between dot centers.

Anti-Aliasing A step effect in which angled lines or curved edges of 
elements in an electronic image look broken or jagged, as a 
result of producing it in a grid format. Increasing resolution can 
reduce this effect or using a technique called anti-aliasing 
where the edges are softened.

Binding The process by which pages of a book or other publication are 
attached to one another.

Bit Abbreviation of binary digits. The smallest unit of information 
used to store information in a computer. Bits are expressed as 
a binary notation, that is, in ones and zeros.

Bitmap graphics An image composed of individual pixels. The color value and 
position of each pixel are individually described in bits and 
bytes of computer memory. It is called a bitmap because it is 
effectively a map of bits. See also Raster file.

Bleed An extra amount of printed image, which extends beyond the 
trim edge of the sheet or page.

Booklet VI jobs are composed of booklets, which are personalized 
copies of a document. A booklet can consist of several pages, 
but the entire document is targeted at a specific individual or 
address. VI jobs include elements that may differ from booklet 
to booklet, including text, graphics, pictures and page 
backgrounds. 

Butt To join without overlapping or space between.

Byte A grouping of 8 bits of stored information, giving 256 levels of 
data. Each byte represents a value or character such as a 
letter or a number. In a color system, a byte can describe one 
out of 256 distinct shades. 

CIE Abbreviation for Commission Internationale d'Eclairage. This 
body was created for the study of illumination problems. CIE 
color coordinates specify proportions of the three additive 
colors required to produce any hue and are used for 
comparative color measurement.
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CMYK The process colors - Cyan, Magenta, Yellow and Black. See 
also Color separations, Process colors, and Subtractive color 
model.

Color gamut The range of colors possible with any color system. 

Color separations Separate films are prepared for each of the process printing 
inks - cyan, magenta, yellow and black. These films are used 
to prepare the printing plates for printing on press. See also 
CMYK.

Composite mode In composite mode, the data required to separate a page into 
its CMYK components is all contained within one single 
(composite) file. Brisque or PS/M then separates the file into 
CMYK as part of the conversion process. This processing 
mode is the fastest and most efficient in the majority of cases.

Crop To eliminate portions of an illustration or photography so the 
remainder is more clear, interesting or able to fit the layout.

CSA (Color Space Array) The spectrum of specific variants of a color model with a 
specific gamut or color range. For example, within the color 
model RGB, there are numerous color spaces, such as Apple 
RGB, sRGB, and Adobe RGB. While each of these define 
color by the same three axes (R, G, and B), they differ in gamut 
and other specifications. CSA is comprised of a three-
dimensional geometric representation of colors that can be 
seen or generated using a certain color model and are 
quantitatively measured. Source CSA is to be used only under 
the assumption that the upstream color workflow was 
managed and monitored. Otherwise it should be replaced with 
a Creo profile, which is the default.

CSA Profiles There are three CSA profiles with gammas of 1.8, 2.1 and 2.4. 
The higher the gamma, the darker the RGB appears. This 
workflow should be used when you have images from different 
sources, such as digital cameras, Internet, and scanners and 
you want the images to have the common RGB color spaces. 
Other possible CSA profiles are sRGB and Adobe RGB.

CT Abbreviation for continuous tone. Color or black and white 
photographic images with tones that change gradually from 
dark to light (unlike the abrupt changes in linework). 
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DCS Abbreviation for Desktop Color Separation, an EPS format 
containing 5 files. Four of the files contain the color 
information for each of the CMYK colors and the fifth is a low-
resolution composite file for use in electronic page layout. 

Degradé A gradual blend or transition between colors. Also known as 
vignette or graduated blend (Vector drawing).

Digital front end system In electronic publishing, this is the workstation or group of 
workstations containing the applications software for 
preparing pages of type and graphics. In prepress, this is the 
workstation that gives access to the user for the operation of 
hardware. For example, proofer, platesetter, imagesetter.

Digital proof A black and white or color image reproduction made from 
digital information without producing intermediate films. It can 
be output as a digital hard proof using a peripheral output 
device or displayed as a digital soft proof on a video monitor.

Dot  The individual element of a halftone.

Dot area The percentage of an area covered by halftone dots ranging 
from no dots at 0% to a solid ink density at 100%. The size of 
a single dot is stated in a percentage of the area it occupies.

DTP Abbreviation for Desktop Publishing. The process of page 
production using personal computers, off-the-shelf software 
and an output device such as a printer or imagesetter. Usually, 
these components form a system that is driven by a device-
independent page description language such as PostScript.

EPS Abbreviation for Encapsulated PostScript, a graphic file 
format used to transfer PostScript, graphic files from one 
program to another. It includes both a low-resolution preview 
and the high resolution PostScript image description. On the 
Macintosh, the preview is in PICT format, on the PC it is in 
TIFF format. Also known as EPSF.

Finishing stage Stage following the press process, which may include 
procedures such as laminating, perforating and varnishing.

Font A complete assortment of letters, numbers, punctuation 
marks, characters etc. of a given design and size.
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Frame A color overlap created intentionally at a color border so as to 
minimize the effects of misregistration. Also known as trap or 
grip. See also Trapping.

Frequency modulated screens A method of creating halftones where the spots are all the 
same size, but the frequency or number of dot changes in a 
given area. There are more dots in a dark area and fewer in a 
light area.

GCR Abbreviation for Gray Component Replacement. Method for 
reducing the CMY amounts that produce the gray component 
in a color, without changing the color hue. 

Graduated blend See Degradé.

Gravure printing  A printing method in which the image is engraved through a 
screen below the surface of a cylinder. The ink is transferred to 
paper when pressed to the cylinder. Gravure is used for very 
long print runs and on many substrates.

Gray component The amounts of CMY in a color, which result in neutral gray, 
based on the lowest separation value of the color. See also 
GCR.

Grayscale A scale of gray tones from white to black. Digitally, grayscale 
images have up to 256 different levels of gray. See also 8 bit/
1 byte image.

Halftone A negative or positive image whereby detail of the image is 
reproduced with dots varying area but of uniform density. 
Creates the illusion of continuous tone when viewed with the 
naked eye.

Held job A job for which the appropriate paper stock is not available, for 
example, the correct paper type, paper size or paper weight.

Highlights The whitest portions of the original or reproduction that have 
no color cast. The highlight dot is ranged in the reproduction 
from the smallest printable dot to approximately 25%. See 
also Midtones and Shadows.
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HSL Abbreviation of Hue, Saturation and Lightness. This is a color 
model, which specifies a color by its wavelength (Hue), 
chroma or purity of the color (Saturation) and value of its 
brightness (Lightness).

Image area Portion of a negative or plate corresponding to inking on 
paper. The portion of paper on which ink appears.

Imposition The arranging of pages in a press form to ensure the correct 
order after the printed sheet is folded, bound and trimmed.

Ink jet proof A proof of a digital image printed by using jets that squirt 
minuscule drops of ink. Ink jet proofers can print onto a variety 
of surfaces.

Job Flow Job flow refers to the job parameter settings of selected virtual 
printers that are automatically applied to all jobs printed using 
that virtual printer. These settings determine how a sent or 
imported file is processed. For example, a file sent to a virtual 
printer with a Process & Print job flow will be RIPped, printed 
and stored in the Storage area. A file sent to a Process & Store 
job flow virtual printer will be RIPped and stored, without 
printing.

LEF A printer page orientation, where pages are delivered long 
edge first.

Laserwriter driver A part of the Macintosh system software which generates 
PostScript instructions from an application file when the Print 
command is activated.

Look-up table (LUT) A two or three-dimensional array of values stored for specified 
input-output relationships. When one input value is known, the 
system can automatically determine the correct output value. 
For example, the system can find the needed dot size for a 
given set of printing conditions based on the stored gray level; 
color setups can be saved in color tables (color transformation 
tables) which are one of the many kinds of LUTs.

Linework Linework graphics are characterized by sharply defined lines 
and very clear transitions from one color to another. Linework 
is stored in the computer as a series of geometric (vector) 
drawing instructions.
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Metamerism Metamerism occurs when two colors match under one light 
source, but appear different under another light source. Those 
two colors are called a metameric match. A metameric match 
might cause problems when trying to match proofs to press-
sheets under different lighting conditions.

Midtones Density values of an image (original or reproduction) between 
the highlights and the shadows. In the reproduction, midtones 
are printed with dot areas between approximately 40% or 
60%. See also Highlights and Shadows.

Misregistration A situation common during printing where one or more of the 
color separations is slightly misaligned with regard to the 
others on press. Misregistration shows up as white gaps or 
tinted overlaps at the borders of color pairs. Colors containing 
such files are trapped to compensate for this possibility. On 
Continous Tone images, misregistration can lead to blurring. 
See also Overprint and Trapping.

Moiré An interference pattern caused by differences in halftone 
screen angles or rulings. In process color printing, screen 
angles are selected to minimize this pattern. If the angles are 
not correct, a pattern that distracts the eye from the picture 
may be produced.

Newton's rings Small concentric circles that can appear on film when two 
surfaces are closed together but not in perfect contact.

Output resolution The number of laser dots per unit of linear measurement 
(millimeter, inch etc.) on film or paper. 

Output tone curve A graph showing the relationship of original input densities 
and the corresponding dot percentages on film. 

Overprint A technique, which overlaps colored elements to eliminate the 
appearance of gaps between elements caused by 
misregistration of the various separations during printing. For 
example, black text is normally set to overprint. See also 
Trapping and Misregistration.
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PDL Printer Description Language files (for example, PostScript, 
PDF, EPS, VPS). The IC-301 print controller processes image 
files in PDL formats, converting them into a suitable Ready-To-
Print format for direct, high-quality printing.

PICT A Macintosh file format for bitmaps and vector graphics.

Perceptual (Photographic) (Default for RGB) A rendering intent method which preserves 
the visual relationship among the colors as they are perceived 
by the human eye. In other words, all colors are proportionally 
scaled to fit the output gamut. All or most colors in the original 
are changed but the relationship between them does not 
change.
This method is recommended when working with realistic 
images such as photographs, including scans and images 
from stock photography CDs.

Pixels Contraction of Picture Element. The smallest element of a 
digital image.

PostScript A programming and page description language that has 
become industry standard for electronic publishing. It is used 
to describe the entire page, including both text graphics and 
images. PostScript is completely independent of the printing 
device. Developed by Adobe Systems, Inc.™

Prepress Generic term used to describe the processes involved in 
preparing images for printing. Includes the input, edit and 
output stages.

Printer description files PPDs (PostScript Printer Definition), and PDFs (Printer 
Definition Files). These files are used by the Macintosh 
applications to prepare page and documents for specific 
output devices.

Process colors The four ink colors used to reproduce full color images - cyan, 
magenta, yellow and black.

Quartertone The tone area of an image influencing highlight detail and with 
density values between the white point and midtone. Typically, 
printed with a dot area near 25%. See also Highlights, 
Midtones, Shadows.
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Raster file A file of data that was scanned, processed or output 
sequentially, bit by bit and line by line. Also known as a 
bitmap.

Rasterization The translation of vector information into bitmap information. 
Bitmaps may also require a new rasterization to comply with 
the screening parameters (dot shape, dot size) of the 
imagesetter that will expose them on film. See also RIP and 
RIPing.

Register Fitting of two or more printing images or plates in exact 
alignment with each other.

Register marks Crosses or other targets applied to original copy prior to 
printing. Used for positioning films in register or for register of 
two or more colors in process printing.

Relative Colorimetric A rendering intent method in which colors that fall within the 
output color space remain the same. Only colors that fall 
outside are changed to the closest possible color within the 
output color space. 
When using this method, some closely related colors in the 
input color space can be mapped to a single color in the 
output color space. This reduces the number of colors in the 
image.
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Rendering Intent All printers, monitors and scanners have a gamut or range of 
colors that they can output (or view in the case of a scanner). 
If a color needs to be output and is outside the gamut of the 
output device, it must be mapped or approximated to some 
other color, which exists within the gamut. Rendering Intent 
enables you to compress out-of-gamut colors into the color 
capability of the press you are using. You can set any 
rendering intent value for RGB elements by selecting the 
required from the Rendering intent options list. The default value 
for RGB is Perceptual (photographic). The default value for 
CMYK is Relative Colorimetric. 

There are several methods that can be used when translating 
colors from one color space to another. These methods are 
called Rendering Intents because they are optimized for 
various uses. When working with ICC profiles, it is important 
that you select the Rendering Intent that best preserves the 
important aspects of the image. Each rendering method 
specifies a CRD for color conversions. You can modify the 
rendering method to control the appearance of images, such 
as prints from office applications or RGB photographs from 
Photoshop.

Resolution The number of pixels, points or dots per unit of linear 
measurement. For example, pixels per millimeter on a video 
display, number of dots per inch or millimeter on film or paper.

The resolution of an image is usually set the same vertically 
and horizontally. For example, a square millimeter with a 
resolution of 12 contains 144 pixels. The higher the resolution, 
the more image detail is recorded and the larger the digital file 
size.

RGB Abbreviation for the additive primaries Red, Green and Blue. 
They are used in video monitors, scanning, and other uses 
where the light is direct and not reflected. The component 
colors are the three predominant colors in the visible light 
spectrum detected by the human eye. Combining these 3 
colors together creates white light.
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RIP Abbreviation for Raster Image Processor. This is a software 
program or hardware device that converts vector information 
into pixel information to be imaged on an output file. This 
output file is imaged based on commands from the page 
description language.

RIPing The process of rastering or converting bitmaps and vector 
graphics into raster images suitable to the screening 
parameters of the output device. Files are RIPed prior to 
exposure or plotting.

Saturated color A color where the high and medium values approach 100%. In 
a saturated clean color, the values of the wanted colors are 
near 100% and the value of the unwanted color is near 0%. 
For example, when the color is red, 5% cyan, 90% magenta, 
80% yellow is more saturated than 30% cyan, 90% magenta, 
80% yellow.

Saturated (presentation) A rendering intent method which scales all colors to the 
strongest saturation possible. The relative saturation is 
maintained from one color space to another.
This rendering style option is optimal for artwork and graphs in 
presentations. In many cases, this style option can be used for 
mixed pages that contain both presentation graphics and 
photographs.

Saturation  The strength of a color.

Screen angle The angle of rows of halftone dots represented in degrees. 
During output of films for reproduction, the dot arrangement of 
each separation film is placed at a distinct and different angle 
to the other separations. See also Moiré.

Screen rulings The number of rows of printing dots per inch on a halftone film. 
A 150lpi-screen ruling provides much better quality than 65lpi.

SEF A printer page orientation, where pages are delivered short 
end first.

Shadows The darkest part of an image (original and reproduction) 
having densities near to maximum density. In the 
reproduction, shadows are printed with dot areas between 
80% and 100% See also Highlights and Midtones.
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Shingling A procedure that moves the image area of a page toward the 
direction specified, usually towards the binding, in order to 
compensate for creep.

Signature Sheet of printed pages which when folded becomes part of 
the publication.

Solid The point in the picture printed with a dot area of 100%. See 
also Highlights, Midtones and Shadows.

Spot color An additional separation (fifth, or more) that is used with 
special inks to achieve difficult color combinations, such as 
gold, or chocolate brown. Spot color is sometimes used by 
graphic artists to define special corporate colors, for example, 
for company logos. On the IC-301 print controller, spot colors 
are tanslated into CMYK values using a dictionary, that can be 
edited to adjust CMYK values.

Step and Repeat The procedure of copying the same image by stepping it in 
position both horizontally and vertically according to a 
predetermined layout.

Stochastic screening A method of creating frequency-modulated halftones that 
depends on the number of laser dots in a given area rather 
than the size of the laser dots in a given area. The dots are 
randomly placed and very small. Areas with a higher dot 
percent have more spots exposed in that area and those with 
a low dot percent have fewer spots. Stochastic screening is 
used to eliminate moiré and improve picture detail and 
sharpness in high-end color printing.

Subtractive color model A color process in which the red, green and blue components 
of the original subject are reproduced as three super-imposed 
images in the complementary (subtractive) colors of cyan, 
magenta and yellow respectively. See also CMYK, Process 
colors, Additive color model.

Three quartertone Tone area of an image influencing the shadow detail and with 
density values between the Midtone and the Dark Point. 
Typically printed with a dot area near 75%.
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Three quartertone Tone area of an image influencing the shadow detail and with 
density values between the Midtone and the Dark Point. 
Typically printed with a dot area near 75%.

Tone compression The reduction of the density range of an original to the density 
range achievable in the reproduction.

Tone reproduction curve A graph showing the density of each point of the original and 
its corresponding density on the reproduction.

Trapping Creating and overlap (spread) or an underlap (choke) between 
colors that adjoin each other to hide misregistration during 
printing. Trapping is sometimes referred to as spreads and 
chokes, or fatties and skinnies.

UCR Abbreviation of Undercolor Removal. This is a method for 
reducing the CMY content in neutral gray shadow areas of a 
reproduction and replacing them with black. As a result, the 
reproduction appears normal but less process color inks are 
used. See also GCR.

Unsaturated color A color whose highest value is less than approximately 80%. 
In an unsaturated, dirty color, the difference in the values of 
the wanted colors and the unwanted color is relatively low. 

For example, when the color is red, 30% cyan, 80% magenta, 
70% yellow is more unsaturated than 0% cyan, 90% 
magenta, 80% yellow.

Variable Information (VI) Variable information (VI) jobs are jobs in which the printed 
materials are individualized for specific recipients or purposes. 
These materials can include bills, targeted advertising and 
direct mailings.

Vector drawing The geometric system used to define lines and curves in many 
computer graphics most often used for line drawings.

Vignette See Degradé.

Virtual printer For Macintosh and Windows networks, the IC-301 print 
controller provides three default network printers, known as 
virtual printers. Virtual printers contain preset workflows that 
are automatically applied to all print jobs processed with that 
virtual printer. 



198 IC-301 Print Controller User Guide

White point The whitest neutral area of an original or reproduction that 
contains detail and is reproduced with the smallest printable 
dot (typically 3% to 5%).



A

Accounting Viewer
printing and exporting,  77
viewing information,  74

Alerts window,  12
AppleTalk Setup,  135
APR/OPI,  177

about,  94
deleting high resolution path,  

178
setting high resolution path,  

177
archiving and retrieving jobs,  64
Auto tray,  158

B

Black overprint,  166
Booklet tray,  172
Brightness slider,  119

C

calibration
about,  104
method,  104
mode,  105
process,  105

Calibration Device,  148
CMYK rendering intent,  170
CMYK source profile,  169
Collated,  172
Color Mode,  167
color tools,  108

Gradation Tool window,  114
Profile Manager,  108
Spot Color Editor,  111

configuration
backup,  153
restoring,  154

Contrast Center,  120
Contrast slider,  119
Copies and Pages,  157
Creep in,  163
Creep out,  163
CT (Continuous Tone) images,  166

Cut & Stack,  159

D

date and time
changing,  131

Destination profile,  170
destination profile

deleting,  111
importing,  110

Disk Wipe,  139
Domain

changing,  130
Downloads page,  36
Duplex

head to head,  157
head to toe,  157

E

Emulate RGB Elements,  170
Emulate Source Paper Tint,  169
EPS,  4
Exceptions,  174
exporting

accounting log,  77
as PDF2Go,  95
job report,  81

F

Face down,  173
file formats supported,  4
fonts,  96

list,  96
managing,  99
using the downloader for Mac,  

99
Force Tray,  158

G

GAP files,  37
Gloss Mode,  158
Gradation,  168
Gradation Tool window

about,  114

controlling brightness,  119
controlling contrast,  119
creating tables,  117
editing tables,  116
navigation buttons,  118
opening,  114
previewing a job,  114
using preview tools,  118

Graphics quality (Text, Line),  164

H

Help menu
opening About window,  18

high-resolution workflow
about,  94
Creo APR,  94

hot folders
about,  36
file formats supported,  37
from Mac OS X,  38
from Windows,  38

I

IC-301 print controller
overview,  2
turning off,  19
turning on,  8

Identify black,  169
Image Position,  174
Image quality,  165
Image/Graphics Quality,  164
importing

destination profiles,  110
files,  44
source profiles,  109

imposition
about,  84
printing brochure,  89
printing business cards,  84
workflows,  84

inline elements,  125
IPX printing

about,  133
setting parameter,  133

Index



200 IC-301 Print Controller User Guide

J

job
abort running,  59
accounting,  74
archiving,  65
batching,  59
deleting,  61
duplicating,  64
importing,  44
moving to storage,  60
on hold,  54
retrieving archived,  66
running,  54
submitting,  64
waiting,  54

Job History window
opening,  149
viewing,  67

Job Info area,  13
job parameters window,  16

Color,  17
Exceptions,  17
Finishing,  17
Imposition,  17
Print,  17
Quality,  17
Services,  17

Job Preview & Editor window
about,  67
Booklet tab,  69
navigation buttons,  67
opening,  67
preview tools,  68
Thumbnails tab,  69

Job Report window,  81
about,  81

L

localization
setting language,  143
setting measurement units,  143

LW (Line Work) images,  111,  166

M

Mac OS 9
copying PPD file,  27
setting network printer,  28

Mac OS X
copying PPD file,  28,  29
setting network printer,  29
using a hot folder,  38

Macintosh
printing from,  31

Main tray,  172
Media Type,  158
menu bar,  10
messages

filtering,  151
printing list,  152
system disks threshold,  149

Messages window,  150,  152

N

network printer
setting for Mac OS 9,  28
setting for Mac OS X,  29

Network Setup,  132

O

on hold status,  54

P

page exceptions
sample workflow,  92

Paper Exit tray,  172
Paper Size,  157,  160
Paper Stock,  157
passwords,  137
PDF2Go

exporting,  95
PDL files,  6,  22
Perfect bound,  160
Personal Print Markup Language 

(PPML),  4,  123
PostScript files

in VI,  125
PPD file

copying for Mac OS 9,  27
copying for Mac OS X,  29
setting job parameters,  156

PPML. See Personal Print Markup 
Language (PPML)

Preferences window
Administrator,  128

date and time,  131
General,  128
Localization,  143
Network Setup,  132
opening,  14,  128
Remote Tools Setup,  136
Security,  137
Server Setup,  129
System disks,  140

Preserve pure colors,  170
Print,  6,  79,  156
Print Method,  157
Print Optimized,  95
Print Order,  172
Print parameter,  156
Print Queue,  42,  54

status indicators,  55
printer driver

copying from Windows,  25
Printer Status pane,  10,  11
Printer’s Default,  26
printing

using a hot folder (Mac OS X),  
38

using a hot folder (Windows),  
38

Process,  6,  79
Process Queue,  42,  54

status indicators,  55
processing a job,  42
Profile Manager

about,  108
deleting profile,  111
importing destination profile,  

110
importing source profile,  109

PS overprint,  166

Q

Quality,  164
QuarkXPress,  112
queues,  10

adding columns,  56
changing order,  58
managing,  54
removing columns,  56
reorder columns,  56
resuming,  58



Index 201

suspending,  58

R

Remote Scanning Application,  46
Remote Tools Setup,  136
Resource Center

Backup & Restore 
Configuration,  153

Fonts,  99
opening,  15
Profile Manager,  108
Virtual Printers,  79

restoring
configuration,  154

resubmitting
processed jobs,  46

reusable elements,  124
RGB rendering intent,  170
RGB source profile,  170

S

Saddle stitch,  160
Saturation,  168
Scaling,  173
scan box

managing,  47
scanned images

managing,  50
Screen Optimized,  95
Screening,  166
Security

Disk Wipe,  139
setting passwords,  137

Separations
buttons,  116

Server name
changing,  129

Server Setup
changing date and time,  131
changing server name,  129

Simplex,  157
Slip sheets between copies,  173
source profiles

deleting,  111
importing,  109

spot color
creating new,  113
deleting,  113

Spot handling,  170
status indicators

in queues,  55
status information,  57
Step & Repeat,  159
Storage area,  6,  35,  43,  60
Store,  6,  79
Sub tray,  172
submitting

job,  42
job from Storage area,  64

suspend /resume button,  58
system disk threshold

setting,  141
System Disks,  140

T

target calibration,  104
TCP/IP Setup,  134
time, changing,  131
title bar,  10
toolbar,  10
Trapping,  165
Tray

Booklet,  172
Main,  172
Paper Exit,  172
Sub,  172

Trim orientation,  161
Trim Size,  160
turning off

IC-301 print controller,  19
turning on

IC-301 print controller,  8

U

user passwords,  137

V

Variable data Intelligent Postscript 
Printware (VIPP),  125

Variable Information (VI)
about,  122
booklet,  124
document formats,  123
inline elements,  125
jobs,  122

printing VI jobs,  126
sub-job,  124

Variable Print Specification (VPS),  
4,  123

virtual printer
adding new,  79
Print,  79
Process,  79
Store,  79

VPS. See Variable Print 
Specification (VPS)

W

Web Center
about,  32
connecting from a client,  33
Downloads page,  36
enabling,  136
Web Viewer,  35

Web Viewer
about,  35
API,  35
Storage area,  35

Windows
copying the PPD file,  25
defining a printer on a client 

workstation,  23
printing from,  26
printing using a hot folder,  38

Windows XP
defining a printer,  23
defining a printer using the add 

printer wizard,  23
workflow

basic,  5,  42
importing and printing from the 

client,  22
imposition,  84
page exceptions,  92
VI,  126

Workgroup
changing,  130

workspace
menu bar,  10
opening,  16
overview,  9
printer status area,  10
queues,  10



202 IC-301 Print Controller User Guide

Storage area,  10
title bar,  10
toolbar,  10





www.konicaminolta.com

Copyright

2005 KONICA MINOLTA BUSSINESS TECHNOLOGIES, INC. 2005.4


	Contents
	Welcome
	Welcome to the IC-301 Print Controller User Guide
	Overview of IC-301 Print Controller
	Hardware and Software Components
	Supported File Formats
	Workflow
	IC-301 Print Controller Network Printers


	Getting Started
	Turning On the IC-301 Print Controller
	The Workspace
	The Printer Status Pane
	The Alerts Window
	The Job Info Area

	The Preferences Window
	The Resource Center
	The Job Parameters Window
	The Help Menu
	Turning Off the IC-301 Print Controller

	Printing From Your Computer
	Overview
	Defining a Printer in Windows
	Defining a Printer - Windows XP
	Copying the Printer Driver from Windows
	Printing From Windows

	Defining a Printer on Macintosh Client Workstations
	Copying the IC-301 Print Controller PPD File for Mac OS 9
	Setting the Network Printer for Mac OS 9
	Copying the IC-301 Print Controller PPD File for Mac OS X (10.3)
	Setting the Network Printer for Mac OS X (10.3)
	Printing from a Macintosh

	Web Center
	The Web Viewer
	Web Viewer API

	Downloads

	Using Hot Folders
	Hot Folder File Formats
	Using Hot Folders From Your Computer

	Setting Up the Remote Desktop

	Basic Workflows
	Basic Job Workflow
	Submitting
	Processing
	Storage

	Importing and Printing Jobs
	Importing Files
	Resubmitting

	Remote Scanning Application
	Setting Up Scan Boxes
	Managing Scanned Images


	Managing Jobs
	Managing the Job Queues
	The Queues
	Status Information
	Suspending and Resuming Queues
	Changing the Order of Jobs in the Queues
	Aborting a Running Job
	Batching Jobs
	Moving a Waiting Job to the Storage Area
	Deleting a Job

	Managing the Storage Area
	Handling Jobs in the Storage Area
	Submitting Jobs
	Duplicating Jobs
	Archiving and Retrieving Jobs
	Viewing the Job History Window


	Previewing a Job
	Navigation Buttons
	Using the Preview Tools
	Viewing Pages in the Job Preview & Editor Window
	The Booklet Tab
	The Thumbnails Tab
	The Imposed Sheets Tab

	Editing an RTP Job
	Copying Pages Into a Job


	Job Accounting
	Viewing the Accounting Information
	Printing and Exporting the Accounting Log

	Creating Virtual Printers
	Job Report

	Production Printing
	Imposition
	Imposition Workflows
	Printing Business Cards
	Printing a Brochure


	Printing with Page Exceptions
	High-Resolution Workflow
	Creo APR
	Export as PDF2Go

	Fonts
	Font List
	Managing Fonts on the IC-301 Print Controller
	Downloading Fonts
	Downloading Fonts in a Macintosh Network
	Downloading Fonts in a Windows Environment



	Color Workflow
	Calibration
	Color Calibration Method
	Choosing a Calibration Mode
	Calibration Process

	Color Tools
	Managing Profiles
	Editing and Creating Spot Colors
	Using the Gradation Tool to Adjust Color
	Previewing a Job
	Editing Gradation Tables
	Creating a New Gradation Table
	Deleting a Gradation Table
	Navigation Buttons
	Using the Preview Tools
	Brightness and Contrast Slider Controls



	VI Workflow
	VI Overview
	VI Document Formats
	Creo Variable Print Specification
	PPML
	PostScript Files

	Using Creo Variable Print Specification to Print a VI Job

	System Administration
	Setting Up and Configuring the IC-301 Print Controller
	Server Setup
	Changing the Server Name
	Changing the Date and Time

	Network Setup
	IPX Printing
	TCP/IP Setup
	Apple Talk Setup

	Remote Tools Setup
	Security
	User Passwords and Access Levels
	Logging On as a Different User
	Disk Wipe

	System Disks
	Scan Management
	Setting the Scanbox Access Control
	Setting the Delete Scan Jobs

	Localization
	Setting the Localization Measurement
	Setting the Language

	Deletion Policy
	Pre-RIP Preview
	Setting the PS Preview Preferences
	Setting the VI Jobs Preview

	Print Queue Manager
	Setting the Job Batching Policy
	Held Jobs Policy

	Default Image Size
	Calibration Device

	System Messages
	System Disks Threshold Message
	Job History
	Message Information

	Messages
	Managing Messages

	Backing Up and Restoring the Configuration


	Setting Parameters
	Setting Parameters in the Job Parameters Window
	Print
	Copies and Pages
	Print Method
	Paper Stock
	Tray

	Imposition
	Imposition Method
	Size
	Templates
	Spacing
	Creep

	Quality
	Image/Graphics Quality
	Trapping
	Overprint
	Screening

	Color
	Color Mode
	Color Adjustments
	Ink Saving
	Color Flow

	Finishing
	Finisher Module
	Print Order
	Slip Sheets
	Layout
	Rotate 180
	Scaling
	Image Position

	Exceptions
	Services
	Admin Page
	APR/OPI
	Job Deletion
	Font Substitution
	PDF Optimization
	Job Info


	Setting Parameters in the PPD File

	Glossary
	Index

